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Product notice

This guide describes features that are common
to most models. Some features may not be
available on your computer.

Not all features are available on all editions of
Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take full
advantage of Windows 8 functionality. See
http://www.microsoft.com for details.

This computer may require upgraded and/ or
separately purchased hardware and/or a DVD
drive to install the Windows 7 software and
take full advantage of Windows 7 functionality.
See http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.

http://www.microsoft.com
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place the
device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do not
allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or
clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible
surface temperature limits defined by the International Standard for Safety of Information Technology
Equipment (IEC 60950).
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1 Product description

Category Description HP/
CPQ14
(Intel)

HP/
CPQ14
(AMD)

HP
240/246
G3

HP
245
G3

Product name HP 14 Notebook PC √ √   

 Compaq 14 Notebook PC √ √   

 HP 240 G3 Notebook PC   √  

 HP 245 G3 Notebook PC    √

 HP 246 G3 Notebook PC   √  

Processors Intel 5th generation processors:

Intel Core i5-5200U (2.2 GHz, SC turbo up to 2.7 GHz, 3-MB L3 Cache,
1600MHz)

Intel Core i3-5010U (2.1 GHz, 3-MB L3 Cache, 1600MHz)

Intel Core i3-5005U (2.0 GHz, 3-MB L3 Cache, 1600MHz)

Intel 4th generation processors:

Intel Core i3-4030U (1.9GHz, 3-MB L3 Cache, 1600MHz)

Intel Core i5-4210U (1.7-GHz, 3-MB L3 cache, 1600-MHz)

Intel Core i3-4010U (1.7-GHz, 3-MB L3 cache, 1600-MHz)

Intel Core i3-4005U (1.7-GHz, 3-MB L3 Cache, 1600MHz)

Intel Core i3-3217U (1.8GHz, 3-MB L3 Cache, 1600MHz)

Intel Bay Trail M processors:

Intel Pentium® N3540 (2.16-GHz, SC turbo up to 2.66 GHz, 2-MB L2 Cache,
1333MHz)

Intel Pentium N3530 (2.58-GHz, 2-MB L2 Cache, 1333MHz)

Intel Pentium N3520 (2.17-GHz, 2-MB L2 Cache, 1333MHz)

Intel Celeron® N2840 (2.58-GHz, SC turbo up to 2.58 GHz, 2-MB L2 Cache,
1333MHz)

Intel Celeron N2830 (2.42-GHz, 2-MB L2 Cache, 1333MHz)

Intel Celeron N2815 (1.86-GHz, 1-MB L2 Cache, 1066MHz)

√  √  

 AMD processors:

A8-6410 (2.0GHz, up to 2.4GHz, 2MB L2), Quad 15W, Max DDR3L-1600

A4-6310 (1.8GHz, 2MB L2), Quad 15W, Max DDR3L-1600

A4-6210 (1.8GHz, 2MB L2), Quad 15W, Max DDR3L-1600

E2-6110 (1.5GHz, 2MB L2), Quad 15W, Max DDR3L-1600

E1-6010 (1.35GHz, 1MB L2), Dual 10W, Max DDR3L-1333

AMD A6-5200 (2.0GHz, 2MB L2, 1600MHz DDR3L), Quad 25W

 √  √
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Category Description HP/
CPQ14
(Intel)

HP/
CPQ14
(AMD)

HP
240/246
G3

HP
245
G3

AMD A4-5000 (1.5GHz, 2MB L2, 1600MHz DDR3L), Quad 15W

AMD E2-3800 (1.3GHz, 2MB L2, 1600MHz DDR3L), Quad 15W

A4-5050 (Quad-core Processor 1.55GHz)

E1-2150 (Dual-core Processor 1.05GHz)

Chipset Intel Lynx Point-LP PCH

Intel HM76 Express Chipset

Intel Bay Trail M

√  √  

 Integrated SOC FCH  √  √

Graphics Internal graphics:*

Intel HD Graphics 5500 (5th generation processors)

Intel HD Graphics 4400 (4th generation processors)

Intel HD Graphics (Bay Trial processors)

*HP 246 G3 models offer only external graphics.

External graphics:

Nvidia 820M N15V-GM 1 GB or 2 GB VRAM

GPU power management enabled at launch

Support DX11

Support dynamic switching

Support HD Decode and HDMI

√  √  

 Internal Graphics:

AMD Radeon™ HD 8400 Graphics

AMD Radeon HD 8330 Graphics

AMD Radeon HD 8210 Graphics

AMD Radeon R5 Graphics

AMD Radeon R3 Graphics

AMD Radeon R2 Graphics

 √  √

 Switchable Discrete Graphics:

AMD Sun LE (18W) Radeon™ HD 8570M with up to 1024MB of dedicated
video memory (support for A4-6300/ A4-5050/E1-6010)

AMD Sun LE (18W) RadeonT HD 8570M with up to 2048MB of dedicated
video memory (support for A8-6500/ A4-6300/ E1-6050/ A4-5000/
A4-5050/ E1-2100)

 √  √

Panel 35.6-cm (14.0-in), high-definition (HD), WLED, SVA, BrightView
(1366×768) display, flat 3.6 mm; typical brightness: 200 nits

35.6-cm (14.0-in), HD, WLED, BrightView (1366×768) display, slim, SVA;
typical brightness: 200 nits (for eTP2 touch solution only)

Touchscreen, multitouch enabled

√ √ √ √
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Category Description HP/
CPQ14
(Intel)

HP/
CPQ14
(AMD)

HP
240/246
G3

HP
245
G3

Supports LVDS

Memory 2 customer-accessible/upgradable memory module slot

Supports dual-channel memory

DDR3L-1600-MHz Single Channel Support

DDR3L-1333-MHz Single Channel Support (DDR3-1600 downgrade to
DDR3-1333)

DDR3L-1066-MHz Single Channel Support (DDR3-1600 downgrade to
DDR3-1066)

Supports up to 16 GB of system RAM in the following configurations:

● 16384-MB total system memory (8192×2)

● 12288-MB total system memory (8192+4096)

● 8192-MB total system memory (8192×1)

● 8192-MB total system memory (4096×2)

● 6144-MB total system memory (4096+2048)

● 4096-MB total system memory (4096×1)

● 4096-MB total system memory (2048×2)

● 2048-MB total system memory (2048×1)

√  √  

 1 customer-accessible/upgradable memory module slot

Supports single-channel memory

DDR3L-1600-MHz Single Channel Support

DDR3L-1333-MHz Single Channel Support (DDR3-1600 downgrade to
DDR3-1333)

Supports up to 8 GB of system RAM in the following configurations:

● 8192-MB total system memory (8192×1)

● 4096-MB total system memory (4096×1)

● 2048-MB total system memory (2048×1)

 √  √

Hard drives Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.
28-in) thicknesses

Serial ATA

Supports the following hard drives:

● 1-TB, 5400-rpm, 9.5-mm

● 750-GB, 5400-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm

● 500-GB, 5400-rpm, 9.5-mm or 7.0-mm

● 320-GB, 5400-rpm, 9.5-mm or 7.0-mm

√ √ √ √

Optical drive Fixed, serial ATA, 9.5-mm tray load

DVD+/-RW Double-Layer SuperMulti

√ √ √ √
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Category Description HP/
CPQ14
(Intel)

HP/
CPQ14
(AMD)

HP
240/246
G3

HP
245
G3

Supports zero power optical drive

Audio/video Single digital microphone

HD audio

Dual speakers

HP TrueVision HD webcam (fixed, no tilt with activity LED, 1280×720 by
30 frames per second)

√ √ √ √

Ethernet Integrated 10/100 network interface card (NIC) √ √ √ √

Wireless Integrated wireless local area network (WLAN) options by way of
wireless module

One or two WLAN antennas built into display assembly

Compatible with Miracast-certified devices

Single antenna support

Support for the following WLAN formats:

● Realtek RTL8188EE 802.11bgn 1x1 Wi-Fi Adapter

● Qualcomm Atheros AR9485 802.11bgn 1x1 Wi-Fi Adapter

● Ralink RT3290LE 802.11bgn 1x1 Wi-Fi + BT 4.0 Combo Adapter

● QCA 9565 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter

● Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC Combo
Adapter

● Realtek RT8723BE 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter

√ √ √ √

 ● Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC Combo
Adapter

● Realtek RT8723BE 802.11bgn 1x1 Wi-Fi + BT4.0 Combo
Adapter_WW

 √ √ √

External
media card

HP Multi-Format Digital Media Reader

Support SD/SDHC/SDXC

Push-Pull Insertion/Removal

√ √ √ √

Ports HDMI version 1.4 supporting 1920 ×1200 @ 60Hz

Hot Plug/unplug and auto detect for correct output to wide-aspect vs.
standard aspect video

RJ-45 (Ethernet, includes link and activity lights)

USB 3.0 (1 port)

USB 2.0 (2 ports)

AC Smart Pin adapter plug

Headphone/microphone in combo jack

√ √ √ √

Keyboard/
pointing
devices

Full-size "island style" keyboard with numeric keypad √ √ √ √
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Category Description HP/
CPQ14
(Intel)

HP/
CPQ14
(AMD)

HP
240/246
G3

HP
245
G3

 TouchPad with multi-touch gestures, 2-finger scrolling, and pinch-
zoom enabled

Taps enabled by default

Support Win8.1+D212 Modern Trackpad Gestures

Support PS/2, profile sensor (reserve for SMBus)

√ √ √ √

Power
requirements

AC adapters:

AC Adapter 65-W Smart nPFC, 3 pin, RC 4.5mm connector - non slim for
use in discrete models

AC Adapter 45-W Smart nPFC, 3 pin, RC 4.5mm connector - non slim for
use in UMA models

AC Adapter 65-W EM Smart nPFC, 3 pin, RC 4.5mm connector, 90 degree
plug design for use in India/China

1 meter power cord

√ √ √ √

 4-cell, 41-Whr Li-ion battery

3-cell, 31-Whr Li-ion battery

√ √ √ √

Security Kensington Security Lock

Support Intel Anti-Theft

Support Intel IPT

OTP support

√  √  

 Kensington Security Lock  √  √

Operating
system

Preinstalled:

● Windows 8.1

● Ubuntu

● FreeDOS 2.0

√ √ √ √

Serviceability End-user replaceable parts:

● AC adapter

● Battery

● Memory

● Optical drive

● Keyboard

√ √ √ √
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2 External component identification

Display

Component Description

(1) WLAN antennas (1 or 2)* (select models only) Send and receive wireless signals to communicate with wireless local
area networks (WLANs).

(2) Webcam light On: The webcam is in use.

(3) Webcam Records video and captures photographs. Some models allow you to
video conference and chat online using streaming video.

To use the webcam in Windows 8, from the Start screen, type
camera, and then select Camera from the list of applications.

To use the webcam in Windows 7, select Start > All Programs >
Communication and Chat > CyberLink YouCam.

(4) Internal microphone Records sound.

(5) Internal display switch Turns off the display and initiates Sleep if the display is closed while
the power is on.

NOTE: The internal display switch is not visible from the outside of
the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices
that applies to your country or region. To access this guide in Windows 8, from the Start screen, type support, and then select the
HP Support Assistant app.
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Front

Component Description

Memory card reader Reads optional memory cards that store, manage,
share, or access information.

To insert a card:

Hold the card label-side up, with connectors facing the
slot, insert the card into the slot, and then push in on the
card until it is firmly seated.

To remove a card:

Pull the card out of the slot.

Right side

Component Description

(1) USB 2.0 ports (2) Connect an optional USB device, such as a keyboard,
mouse, external drive, printer, scanner or USB hub.

(2)  Optical drive Depending on your computer model, reads an optical
disc or reads and writes to an optical disc.

NOTE: For disc compatibility information, go to the
Help and Support web page. Follow the web page
instructions to select your computer model. Select
Support & Drivers, and then select Product
Information.

(3)  Optical drive eject button Releases the disc tray.
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Left side

Component Description

(1)  Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or
stolen.

(2) Power connector Connects an AC adapter.

(3)  AC adapter light ● White: The AC adapter is connected and the battery is
charged.

● Amber: The AC adapter is connected and the battery is
charging.

● Off: The computer is using battery power.

(4)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(5) External monitor port (select models only) Connects an external VGA monitor or projector.

(6) HDMI port Connects an optional video or audio device, such as a high-
definition television, any compatible digital or audio
component, or a high-speed HDMI device.

(7) RJ-45 (network) jack/status lights Connects a network cable.

● White: The network is connected.

● Amber: Activity is occurring on the network.

(8) USB 3.0 port Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner or USB hub.

(9) Audio-out (headphone)/Audio-in (microphone)
jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable. Also connects an
optional headset microphone. This jack does not support
optional microphone-only devices.

Left side 9



Component Description

WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, refer to the Regulatory,
Safety, and Environmental Notices. To access this guide in
Windows 8, from the Start screen, type support, and then
select the HP Support Assistant app.

NOTE: When a device is connected to the jack, the computer
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and audio-
in (microphone).

(10) Hard drive light Blinking white: The hard drive is being accessed.

(11) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a power-
saving state. The computer shuts off power to the display
and other unneeded components.

● Off: The computer is off or in Hibernation. Hibernation is a
power-saving state that uses the least amount of power.

NOTE: For select models, the Intel® Rapid Start Technology
feature is enabled at the factory. Rapid Start Technology allows
your computer to resume quickly from inactivity.
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Top

TouchPad

Component Description

(1)  TouchPad zone Moves the on-screen pointer and selects or activates items on
the screen.

NOTE: The TouchPad also supports edge-swipe gestures.

(2)  Left TouchPad button Functions like the left button on an external mouse.

(3)  Right TouchPad button Functions like the right button on an external mouse.
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Lights

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a power-
saving state. The computer shuts off power to the display
and other unneeded components.

● Off: The computer is off or in Hibernation. Hibernation is a
power-saving state that uses the least amount of power.

(2)  Caps lock light On: Caps lock is on, which switches the keys to all capital letters.

(3) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(4) Wireless light On: An integrated wireless device, such as a wireless local area
network (WLAN) device and/or a Bluetooth® device, is on.

NOTE: On some models, the wireless light is amber when all
wireless devices are off.
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Button

Component Description

 Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press the button
briefly to exit Sleep.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will
result in the loss of unsaved information.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button down for at least 5 seconds to turn off the computer.

NOTE: For select models, the Intel® Rapid Start Technology
feature is enabled at the factory. Rapid Start Technology allows
your computer to resume quickly from inactivity.

To learn more about your power settings, see your power
options.

In Windows 8, from the Start screen, type power, select Power
and sleep settings, and then select Power and sleep from the
list of applications.

In Windows 7, select Start > Control Panel > System and
Security > Power Options,
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Keys

Component Description

(1)  esc key Displays system information when pressed in combination with
the fn key.

(2)  fn key Executes frequently used system functions when pressed in
combination with the spacebar or the esc key.

(3) Windows key Windows 8: Returns you to the Start screen from an open app or
the Windows desktop.

NOTE: Pressing the Windows key again will return you to the
previous screen.

Windows 7: Displays the Windows Start menu.

(4)  Action keys Execute frequently used system functions.
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Bottom

Component Description

(1) Battery lock and unlock latch Locks and unlocks the battery in the battery bay.

(2)  Battery bay Holds the battery.

(3)  Vent Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Battery release latch Releases the battery.

(5)  Speaker openings (4) Produce sound.

(6) Service cover (select models only) Provides access to the memory module slots.
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Labels
The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer.

IMPORTANT: All labels described in this section will be located in one of 2 places depending on your
computer model: Affixed to the bottom of the computer, or located in the battery bay.

● Service label—Provides important information to identify your computer. When contacting support,
you will probably be asked for the serial number, and possibly for the product number or the model
number. Locate these numbers before you contact support.

NOTE: Your service labels will resemble one of the examples shown below. Refer to the illustration
that most closely matches the service label on your computer.

Component  

(1) Product name

(2) Serial number

(3) Product number

(4) Warranty period

(5) Model number (select models only)

Component  

(1) Serial number  

(2) Product number  

(3) Warranty period  
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Component  

(4) Model number (select models only)  

(5) Revision number  

● Regulatory label(s)—Provide(s) regulatory information about the computer.

● Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval
markings for the countries or regions in which the devices have been approved for use.

Labels 17
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3 Illustrated parts catalog

Computer major components
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Computer major components 19
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Item Component Spare part number

(1) Display assembly (35.6-cm [14.0-in] HD, anti-glare, WLED)

NOTE: For display assembly spare part information, see Display assembly subcomponents on page 27.

(2) Keyboard  

 For use in the United States 757922-001

 For use in the United Kingdom 757922-031

 For use in France 757922-051

 For use in Spain 757922-071

 For use in Portugal 757922-131

 For use in Turkey 757922-141

 For use in Latin America 757922-161

 For use in Saudi Arabia 757922-171

 For use in Brazil 757922-201

 For use in Russia 757922-251

 For use in Thailand 757922-281

 For use in Japan 757922-291

 For use in Taiwan 757922-AB1

 For use in South Korea 757922-AD1

 For use in the Netherlands 757922-B31

 For use in Israel 757922-BB1

 For use in Switzerland 757922-BG1

 For use in French Canada 757922-DB1

 For use in Denmark, Finland, and Norway 757922-DH1

 For use in the Czech Republic and Slovakia 757922-FL1

(3) Top cover (includes touchpad)  

 For use in HP 14 and Compaq 14 models:  

 ● Black 757613-001

 ● Gray 758618-001

 ● White 758911-001

 ● Red 758912-001

 ● Blue 758913-001

 ● Silver 760247-001

 For use in HP 245 G3 models:  

 ● Top cover 758618-001

 For use in HP 240/246 G3 models:  
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Item Component Spare part number

 ● Top cover 773067-001

(4) Power connector cable 760104-001

(5) Touchpad button board (includes cables) 757609-001

(6) Fan 753894-001

(7) RTC battery 759981-001

(8) Power button board (includes cable) 757607-001

(9a) For use in models with Intel processors and discrete graphics 757602-001

 For use in models with an Intel Core i3-3217U processor and discrete graphics 766502-001

 For use in models with AMD processors and discrete graphics 766567-001

(9b) For use in models with Intel processors and UMA graphics 757603-001

 For use in models with Intel Pentium and Celeron processors and UMA graphics 766504-001

 For use in models with an Intel Core i3-3217U processor and UMA graphics 766503-001

 For use in models with AMD processors and UMA graphics 766568-001

(10) System board (includes replacement thermal materials):

All Intel system boards use the following part numbers:

xxxxxx-001: Without the Windows operating system

xxxxxx-501: Windows 8.1 Standard

xxxxxx-601: Windows 8.1 Professional

 HP 14, Compaq 14, and HP 240/246 G3 models with Intel processors:

NOTE: HP 246 G3 models offer only discrete graphics.

 Non-touch screen models with an Intel Core i5-5200U processor and 2 GB of discrete graphics 762240-xxx

 Non-touch screen models with an Intel Core i3-5010U processor and 2 GB of discrete graphics 801857-xxx

 Non-touch screen models with an Intel Core i3-5010U processor and UMA graphics 801855-xxx

 Non-touch screen models with an Intel Core i3-5005U processor and 2 GB of discrete graphics 791095-xxx

 Non-touch screen models with an Intel Core i3-5005U processor and 1 GB of discrete graphics 791094-xxx

 Non-touch screen models with an Intel Core i3-5005U processor and UMA graphics 791093-xxx

 Non-touch screen models with an Intel Core i5-4210U processor and UMA graphics 755835-xxx

 Non-touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete graphics 779080-xxx

 Non-touch screen models with an Intel Core i3-4030U processor and 1 GB of discrete graphics 779079-xxx

 Non-touch screen models with an Intel Core i3-4030U processor and UMA graphics 779078-xxx

 Non-touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics 778116-xxx

 Non-touch screen models with an Intel Core i3-4010U processor and UMA graphics 755831-xxx

 Non-touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics 755832-xxx

 Non-touch screen models with an Intel Core i3-4005U processor and UMA graphics 765364-xxx
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Item Component Spare part number

 Non-touch screen models with an Intel Pentium N3540 processor and UMA graphics 788003-xxx

 Touch screen models with an Intel Pentium N3540 processor and UMA graphics 788208-xxx

 Non-touch screen models with an Intel Celeron N2920 processor and UMA graphics 790213-xxx

 Non-touch screen models with an Intel Celeron N2840 processor and UMA graphics 788004-xxx

 Non-touch screen models with an Intel Celeron N2820 processor and UMA graphics 790212-xxx

 Non-touch screen models with an Intel Celeron N2805 processor and UMA graphics 790211-xxx

 HP 14 and Compaq 14 models with Intel processors:  

 Non-touch screen models with an Intel Core i5-5200U processor and 1 GB of discrete graphics 791096-xxx

 Non-touch screen models with an Intel Core i5-5200U processor and UMA graphics 776890-xxx

 Non-touch screen models with an Intel Core i3-5010U processor and 1 GB of discrete graphics 801856-xxx

 Non-touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics 755834-xxx

 Touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics 757610-xxx

 Non-touch screen models with an Intel Core i5-4210U processor and 1 GB of discrete graphics 788210-xxx

 Touch screen models with an Intel Core i5-4030U processor and 2 GB of discrete graphics 784981-xxx

 Touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics 758614-xxx

 Non-touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics 755833-xxx

 Touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics 758613-xxx

 Touch screen models with an Intel Core i3-4005U processor and UMA graphics 773153-xxx

 Non-touch screen models with an Intel Core i3-4005U processor and 1 GB of discrete graphics 773154-xxx

 Touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics 755836-xxx

 Non-touch screen models with an Intel Core i3-3217U processor and UMA graphics 755829-xxx

 Non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete graphics 755830-xxx

 Touch screen models with an Intel Core i3-3217U processor and UMA graphics 762239-xxx

 Touch screen models with an Intel Pentium N3530 processor and UMA graphics 764051-xxx

 Non-touch screen models with an Intel Pentium N3520 processor and UMA graphics 755837-xxx

 Non-touch screen models with an Intel Celeron N2830 processor and UMA graphics 764050-xxx

 Non-touch screen models with an Intel Celeron N2815 processor and UMA graphics 755838-xxx

 HP 240/246 G3 models:

NOTE: HP 246 G3 models offer only discrete graphics.

 Non-touch screen models with an Intel Pentium N3530 processor and UMA graphics 775631-xxx

 Non-touch screen, GLAN models with an Intel Core i5-4210U processor and UMA graphics 795135-xxx

 Non-touch screen, GLAN models with an Intel Core i3-4030 processor and UMA graphics 795136-xxx

 Non-touch screen, GLAN models with an Intel Core i5-4005U processor and UMA graphics 794733-xxx

 Non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete graphics 766646-xxx
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Item Component Spare part number

 Non-touch screen models with an Intel Core i3-3217U processor and UMA graphics 766645-xxx

 Non-touch screen, GLAN models with an Intel Core i3-3217U processor and UMA graphics 795137-xxx

 Touch screen models with an Intel Core i3-3217U processor and UMA graphics 776462-xxx

 Non-touch screen models with an Intel Pentium N3530 processor and UMA graphics 775629-xxx

 Non-touch screen models with an Intel Celeron N2830 processor and UMA graphics 775632-xxx

 Non-touch screen models with an Intel Celeron N2815 processor and UMA graphics 775630-xxx

 HP 14, Compaq 14, and HP 245 G3 models with AMD processors

 AMD A8-6410 processor with UMA graphics without a touch screen

 ● Without Windows 8 764170-001

 ● Windows 8 Standard 764170-501

 AMD A8-6410 processor with UMA graphics memory and a touch screen

 ● Without Windows 8 764171-001

 ● Windows 8 Standard 764171-501

 AMD A8-6410 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 764176-001

 ● Windows 8 Standard 764176-501

 AMD A4-6210 processor with UMA graphics without a touch screen

 ● Without Windows 8 764172-001

 ● Windows 8 Standard 764172-501

 AMD A4-6210 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 764171-001

 ● Windows 8 Standard 764171-501

 AMD A4-6210 processor with 1 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 764175-001

 ● Windows 8 Standard 764175-501

 AMD E2-6110 processor with UMA graphics without a touch screen

 ● Without Windows 8 764173-001

 ● Windows 8 Standard 764173-501

 AMD E1-6010 processor with UMA graphics without a touch screen

 ● Without Windows 8 764174-001

 ● Windows 8 Standard 764174-501

 AMD E1-6010 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 764178-001

 ● Windows 8 Standard 764178-501
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Item Component Spare part number

 AMD E1-6010 processor with 1 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 776931-001

 ● Windows 8 Standard 776931-501

 AMD A6-5200 processor with UMA graphics without a touch screen

 ● Without Windows 8 762422-001

 ● Windows 8 Standard 762422-501

 ● Windows 8 Professional 762422-601

 AMD A6-5200 processor with UMA graphics memory and a touch screen

 ● Without Windows 8 762423-001

 ● Windows 8 Standard 762423-501

 AMD A4-5050 processor with UMA graphics without a touch screen

 ● Without Windows 8 762425-001

 ● Windows 8 Standard 762425-501

 AMD A4-5050 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 762430-001

 ● Windows 8 Standard 762430-501

 AMD A4-5050 processor with 1 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 762428-001

 ● Windows 8 Standard 762428-501

 AMD A4-5000 processor with UMA graphics without a touch screen

 ● Without Windows 8 762427-001

 ● Windows 8 Standard 762427-501

 ● Windows 8 Professional 762427-601

 AMD A4-5000 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 762431-001

 ● Windows 8 Standard 762431-501

 AMD E2-3800 processor with UMA graphics without a touch screen

 ● Without Windows 8 762421-001

 ● Windows 8 Standard 762421-501

 ● Windows 8 Professional 762421-601

 AMD E1-2150 processor with UMA graphics without a touch screen

 ● Without Windows 8 762426-001

 ● Windows 8 Standard 762426-501

 AMD E1-2100 processor with UMA graphics without a touch screen
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Item Component Spare part number

 ● Without Windows 8 762424-001

 ● Windows 8 Standard 762424-501

 ● Windows 8 Professional 762424-601

 AMD E1-2100 processor with 2 GB of discrete graphics memory without a touch screen

 ● Without Windows 8 762429-001

 ● Windows 8 Standard 762429-501

 HP 245 G3 models:  

 AMD A4-5000 processor and 1 GB of discrete graphics without a touch screen:  

 ● Without Windows 8 766011-001

 ● Windows 8 Standard 766011-501

 ● Windows 8 Professional 766011-601

 AMD A6-6310 processor and UMA graphics memory with a touch screen:  

 ● Without Windows 8 793101-001

 ● Windows 8 Standard 793101-501

 ● Windows 8 Professional 793101-601

 Heat sink assembly (includes replacement thermal materials):  

(11) WLAN module:

 Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-005

 Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter 690020-005

 Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter for use in Brazil 712639-205

 Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-005

 Realtek RT8723BE 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter 753077-005

(12) USB board (includes cable) 757608-001

(13) Speakers (includes left and right speakers and cable) 757612-001

(14) Optical drive (DVD+/-RW Double-Layer SuperMulti)  

 For use in HP 14 and Compaq 14 models 757606-001

 For use in HP 240/246 and 245 G3 models 766899-001

(15) Hard drive (SATA; does not include bracket):

NOTE: The hard drive bracket is available using spare part number 758615-001.

 1-GB, 5400-rpm 778192-005

 750-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778190-001

 750-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 634250-005

 500-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778188-001

 500-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 669299-005
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Item Component Spare part number

 500-GB, 5400-rpm, 7 mm (HP 240/246 G3 models only) 683802-005

(16) Battery:

 4-cell, 41-Whr, 2.8-Ah Li-ion battery 740715-001

 3-cell, 31-Whr, 2.8-Ah Li-ion battery 746641-001

 Base enclosure kit, includes:  

 ● For use in HP 14 and Compaq 14 models 757598-001

 ● For use in HP 240/246 and HP 245 G3 models 766898-001

(17) Base enclosure  

(18) Left and right rear covers  

 Lock bracket (not illustrated)  

(19) Memory module (PC3L, 12800, 1600-MHz):

 8-GB 693374-001

 4 GB 691740-001

 2 GB 691739-001

(20) Service cover 758616-001
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel (includes Mylar screw covers):

 For use with HP 14 models 757599-001

 For use with HP 240/246 G3 models 766009-001

 For use with HP 245 G3 models 766900-001

 For use with Compaq 14 models 757600-001

(2) Webcam/microphone module  

 HD 757614-001

 VGA 781623-001

(3) Raw display panel (35.6-cm [14.0-in], HD, WLED, BrightView)  

 Non-touch screen, HP 14 and Compaq 14 models 760105-001

 Non-touch screen, HP 240/246 G3 models 766010-001

 Touch screen, Compaq 14 models 757611-001
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Item Component Spare part number

 Touch screen, HP 14 models 760106-001

 Touch screen, HP 245 G3 models 778156-001

(4) Hinges (left and right)  

 Non-touch screen models 757605-001

 Touch screen models 766585-001

(5) Display cable (includes display panel cable and webcam/microphone cable)  

 Non-touch screen models 757601-001

 Touch screen models 757597-001

(6) Antennas (includes wireless antenna cables and transceivers)  

 Non-touch screen models 757596-001

 Touch screen models 766589-001

(7) Display enclosure:  

 Models without a touch screen:  

 ● For use in HP 240/246 and HP 245 G3 models 766896-001

 ● For use in HP 240/246 and HP 245 G3 models 766897-001

 ● For use in silver HP 14 models 757604-001

 ● For use in black HP 14 models 758603-001

 ● For use in white HP 14 models 758604-001

 ● For use in red HP 14 models 758605-001

 ● For use in blue HP 14 models 758606-001

 ● For use in gray Compaq 14 non-touch screen models 758607-001

 ● For use in gray Compaq 14 touch screen models 791174-001

 ● For use in gray HP 14 models 760102-001

 Models with a touch screen:  

 ● For use in black HP 14 and Compaq 14 models 758608-001

 ● For use in white HP 14 and Compaq 14 models 758609-001

 ● For use in red HP 14 and Compaq 14 models 758610-001

 ● For use in blue HP 14 and Compaq 14 models 758611-001

 ● For use in silver HP 14 and Compaq 14 models 760246-001

 ● For use in gray HP 14 and Compaq 14 models 760103-001
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Mass storage devices

Item Component Spare part number

(1) Optical drive (DVD+/-RW Double-Layer SuperMulti)  

 For use in HP 14 and Compaq 14 models 757606-001

 For use in HP 240/246 and 245 G3 models 766899-001

(2) Hard drive, SATA; does not include bracket):  

 1-GB, 5400-rpm 778192-005

 750-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778190-005

 750-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 634250-005

 500-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778188-005

 500-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 669299-005

 500-GB, 5400-rpm, 7 mm (HP 240/246 G3 models only) 683802-005

 Hard Drive Hardware Kit (includes bracket and screws) 758615-001

Miscellaneous parts

Component Spare part number

HP Smart AC adapter:

65-W non-PFC EM HP Smart AC adapter (for use in the People’s Republic of China and India only) 714657-001

65-W non-PFC EM HP Smart AC adapter 710412-001

45-W non-PFC, non-slim HP Smart AC adapter (for use in all countries and regions except for the
People’s Republic of China and India)

741427-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1
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Component Spare part number

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Power cord (3-pin, black, 1.0-m):

For use in Argentina 755530-D01

For use in Australia 755530-011

For use in Brazil 755530-202

For use in Denmark 755530-081

For use in Europe, the Middle East, and Africa 755530-021

For use in India 755530-D61

For use in Italy 755530-061

For use in Japan 755530-291

For use in North America 755530-001

For use in the People’s Republic of China 755530-AA1

For use in South Korea 755530-AD1

For use in Switzerland 755530-111

For use in Taiwan 755530-AB1

For use in Thailand 755530-201

For use in the United Kingdom and Singapore 755530-031

Rubber feet for use on HP 14 and Compaq 14 models 766505-001

Screw Kit 758617-001

Sequential part number listing

Spare part
number

Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe, the Middle East, and Africa (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)
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Spare part
number

Description

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

683802-005 500-GB, 5400-rpm, 7 mm (HP 240/246 G3 models only; does not include cable or bracket)

634250-005 750-GB, 5400-rpm hard drive (HP 240/246 and HP 245 G3 models only; does not include cable or bracket)

669299-005 500-GB, 5400-rpm hard drive (HP 240/246 and HP 245 G3 models only; does not include cable or bracket)

675794-005 Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter

690020-005 Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter

691739-001 2-GB memory module (PC3L, 12800, 1600-MHz)

691740-001 4-GB memory module (PC3L, 12800, 1600-MHz)

693374-001 8-GB memory module (PC3L, 12800, 1600-MHz)

709848-005 Realtek RTL8188EE 802.11bgn Wi-Fi Adapter

710412-001 65-W non-PFC EM HP Smart AC adapter

714657-001 65-W non-PFC EM HP Smart AC adapter (for use in the People’s Republic of China and India only)

712639-205 Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter for use in Brazil

740715-001 4-cell, 41-Whr, 2.8-Ah Li-ion battery

741427-001 45-W non-PFC, non-slim HP Smart AC adapter (for use in all countries and regions except for the People’s Republic of
China and India)

746641-001 3-cell, 31-Whr, 2.8-Ah Li-ion battery

753077-005 Realtek RT8723BE 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter

753894-001 Fan

755530-001 Power cord for use in North America (3-pin, black, 1.00-m)

755530-011 Power cord for use in Australia (3-pin, black, 1.00-m)

755530-021 Power cord for use in Europe (3-pin, black, 1.83-m)

755530-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

755530-061 Power cord for use in Italy (3-pin, black, 1.00-m)

755530-081 Power cord for use in Denmark (3-pin, black, 1.00-m)

755530-111 Power cord for use in Switzerland (3-pin, black, 1.00-m)

755530-201 Power cord for use in Thailand (3-pin, black, 1.00-m)

755530-202 Power cord for use in Brazil (3-pin, black, 1.00-m)

755530-291 Power cord for use in Japan (3-pin, black, 1.00-m)
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Spare part
number

Description

755530-AA1 Power cord for use in the People’s Republic of China (3-pin, black, 1.00-m)

755530-AB1 Power cord for use in Taiwan (3-pin, black, 1.00-m)

755530-AD1 Power cord for use in South Korea (3-pin, black, 1.00-m)

755530-D01 Power cord for use in Argentina (3-pin, black, 1.00-m)

755530-D61 Power cord for use in India (3-pin, black, 1.00-m)

755829-001 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14
and Compaq 14 models without Windows 8

755829-501 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Standard

755829-601 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Professional

755830-001 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

755830-501 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

755830-601 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

755831-001 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8 and
equipped with an Intel Core i3-4010U processor and UMA graphics (includes replacement thermal materials)

755831-501 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard
and equipped with an Intel Core i3-4010U processor and UMA graphics (includes replacement thermal materials)

755831-601 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8
Professional and equipped with an Intel Core i3-4010U processor and UMA graphics (includes replacement
thermal materials)

755832-001 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8 and
equipped with an Intel Core i3-4010U processor and 1 GB of discrete graphics (includes replacement
thermal materials)

755832-501 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard
and equipped with an Intel Core i3-4010U processor and 1 GB of discrete graphics (includes replacement
thermal materials)

755832-601 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8
Professional and equipped with an Intel Core i3-4010U processor and 1 GB of discrete graphics (includes replacement
thermal materials)

755833-001 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

755833-501 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

755833-601 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

755834-001 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

755834-501 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard
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number

Description

755834-601 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

755835-001 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8 and
equipped with an Intel Core i5-4210U processor and UMA graphics (includes replacement thermal materials)

755835-501 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard
and equipped with an Intel Core i5-4210U processor and UMA graphics (includes replacement thermal materials)

755835-601 System board for use in non-touch screen HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8
Professional and equipped with an Intel Core i5-4210U processor and UMA graphics (includes replacement
thermal materials)

755836-001 System board for use in touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models without Windows 8

755836-501 System board for use in touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Standard

755836-601 System board for use in touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Professional

755837-001 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP 14
and Compaq 14 models without Windows 8

755837-501 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Standard

755837-601 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Professional

755838-001 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 14
and Compaq 14 models without Windows 8

755838-501 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Standard

755838-601 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Professional

757596-001 Antennas for use in non-touch screen models (includes wireless antenna cables and transceivers)

757597-001 Display cable for use in touch screen models (includes display panel cable and webcam/microphone cable)

757598-001 Base enclosure for use in HP 14 and Compaq 14 (includes left and right rear covers and lock bracket)

757599-001 Display bezel for use with HP 14 models

757600-001 Display bezel for use with Compaq 14 models

757601-001 Display cable for use in non-touch screen models (includes display panel cable and webcam/microphone cable)

757602-001 Heat sink assembly for use in models with Intel processors and discrete graphics
(includes replacement thermal materials)

757603-001 Heat sink assembly for use in models with Intel processors and UMA graphics
(includes replacement thermal materials)

757604-001 Display enclosure for use in silver HP 14 models

757605-001 Hinges for use in models without a touch screen (left and right)

757606-001 DVD+/-RW Double-Layer SuperMulti Drive for use in HP 14 and Compaq 14 models

757607-001 Power button board (includes cable)
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757608-001 USB board (includes cable)

757609-001 TouchPad button board (includes cables)

757610-001 System board for use in touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models without Windows 8

757610-501 System board for use in touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Standard

757610-601 System board for use in touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Professional

757611-001 Raw display panel for use in Compaq 14 models, touch screen

757612-001 Speakers (includes left and right speakers and cable)

757613-001 Top cover for use in black HP 14 and Compaq 14 models (includes touchpad)

757614-001 Webcam/microphone module, HD

757922-001 Keyboard for use in the United States

757922-031 Keyboard for use in the United Kingdom

757922-041 Keyboard for use in Germany

757922-051 Keyboard for use in France

757922-071 Keyboard for use in Spain

757922-131 Keyboard for use in Portugal

757922-141 Keyboard for use in Turkey

757922-151 Keyboard for use in Greece

757922-161 Keyboard for use in Latin America

757922-171 Keyboard for use in Saudi Arabia

757922-201 Keyboard for use in Brazil

757922-211 Keyboard for use in Hungary

757922-251 Keyboard for use in Russia

757922-261 Keyboard for use in Bulgaria

757922-271 Keyboard for use in Romania

757922-281 Keyboard for use in Thailand

757922-291 Keyboard for use in Japan

757922-AB1 Keyboard for use in Taiwan

757922-AD1 Keyboard for use in South Korea

757922-B31 Keyboard for use in the Netherlands

757922-BA1 Keyboard for use in Slovania

757922-BB1 Keyboard for use in Israel

757922-BG1 Keyboard for use in Switzerland

34 Chapter 3   Illustrated parts catalog



Spare part
number

Description

757922-DB1 Keyboard for use in French Canada

757922-DH1 Keyboard for use in Denmark, Finland, and Norway

757922-FL1 Keyboard for use in the Czech Republic and Slovakia

758603-001 Display enclosure for use in black HP 14 models

758604-001 Display enclosure for use in white HP 14 models

758605-001 Display enclosure for use in red HP 14 models

758606-001 Display enclosure for use in blue HP 14 models

758607-001 Display enclosure for use in gray Compaq 14 non-touch screen models

758608-001 Display enclosure for use in black HP 14 and Compaq 14 models with a touch screen

758609-001 Display enclosure for use in white HP 14 and Compaq 14 models with a touch screen

758610-001 Display enclosure for use in red HP 14 and Compaq 14 models with a touch screen

758611-001 Display enclosure for use in blue HP 14 and Compaq 14 models with a touch screen

758613-001 System board for use in touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics in
HP 14 and Compaq 14 models without Windows 8

758613-501 System board for use in touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Standard

758613-601 System board for use in touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Professional

758614-001 System board for use in touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models without Windows 8

758614-501 System board for use in touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Standard

758614-601 System board for use in touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics in
HP 14 and Compaq 14 models with Windows 8 Professional

758615-001 Hard Drive Hardware Kit (includes bracket and screws)

758616-001 Service cover

758617-001 Screw Kit

758618-001 Top cover for use in gray HP 14, Compaq 14, and HP 245 G3 models (includes touchpad)

758911-001 Top cover for use in white HP 14 and Compaq 14 models (includes touchpad)

758912-001 Top cover for use in red models (includes touchpad)

758913-001 Top cover for use in blue HP 14 and Compaq 14 models (includes touchpad)

759981-001 RTC battery

760102-001 Display enclosure for use in gray HP 14 and Compaq 14 HP models without a touch screen

760103-001 Display enclosure for use in gray HP 14 and Compaq 14 models with a touch screen

760104-001 Power connector cable

760105-001 Raw display panel for use in HP 14 and Compaq 14 models, non-touch screen
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760106-001 Raw display panel for use in HP 14 models, touch screen

760246-001 Display enclosure for use in silver HP 14 and Compaq 14 models with a touch screen

760247-001 Top cover for use in silver models (includes touchpad)

762239-001 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14 and
Compaq 14 models without Windows 8

762239-501 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Standard

762239-601 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Professional

762240-001 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

762240-501 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

762240-601 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

762421-001 System board for use in models with an AMD E2-3800 processor, with UMA graphics, without a touch screen, and
without Windows 8

762421-501 System board for use in models with an AMD E2-3800 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762421-601 System board for use in models with an AMD E2-3800 processor, with UMA graphics, without a touch screen, with
Windows 8 Professional

762422-001 System board for use in models with an AMD A6-5200 processor, with UMA graphics, without a touch screen, without
Windows 8

762422-501 System board for use in models with an AMD A6-5200 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762422-601 System board for use in models with an AMD A6-5200 processor, with UMA graphics, without a touch screen, with
Windows 8 Professional

762423-001 System board for use in models with an AMD A6-5200 processor, with UMA graphics, with a touch screen, with a
touch screen, without Windows 8

762423-501 System board for use in models with an AMD A6-5200 processor, with UMA graphics, with a touch screen, with a
touch screen, with Windows 8 Standard

762424-001 System board for use in models with an AMD E1-2100 processor, with UMA graphics, without a touch screen, without
Windows 8

762424-501 System board for use in models with an AMD E1-2100 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762424-601 System board for use in models with an AMD E1-2100 processor, with UMA graphics, without a touch screen, with
Windows 8 Professional

762425-001 System board for use in models with an AMD A4-5050 processor, with UMA graphics, without a touch screen, without
Windows 8

762425-501 System board for use in models with an AMD A4-5050 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762426-001 System board for use in models with an AMD E1-2150 processor, with UMA graphics, without a touch screen, without
Windows 8
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762426-501 System board for use in models with an AMD E1-2150 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762427-001 System board for use in models with an AMD A4-5000 processor, with UMA graphics, without a touch screen, without
Windows 8

762427-501 System board for use in models with an AMD A4-5000 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

762427-601 System board for use in models with an AMD A4-5000 processor, with UMA graphics, without a touch screen, with
Windows 8 Professional

762428-001 System board for use in models with an AMD A4-5050 processor, with 1 GB of discrete graphics, without a touch
screen, without Windows 8

762428-501 System board for use in models with an AMD A4-5050 processor, with 1 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

762429-001 System board for use in models with an AMD E1-2100 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

762429-501 System board for use in models with an AMD E1-2100 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

762430-001 System board for use in models with an AMD A4-5050 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

762430-501 System board for use in models with an AMD A4-5050 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

762431-001 System board for use in models with an AMD A4-5000 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

762431-501 System board for use in models with an AMD A4-5000 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

764050-001 System board for use in non-touch screen models with an Intel Celeron N2830 processor and UMA graphics in HP 14
and Compaq 14 models without Windows 8

764050-501 System board for use in non-touch screen models with an Intel Celeron N2830 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Standard

764050-601 System board for use in non-touch screen models with an Intel Celeron N2830 processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Professional

764051-001 System board for use in touch screen models with an Intel Pentium N3530 processor and UMA graphics in HP 14 and
Compaq 14 models without Windows 8

764051-501 System board for use in touch screen models with an Intel Pentium N3530 processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Standard

764051-601 System board for use in touch screen models with an Intel Pentium N3530 processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Professional

764170-001 System board for use in models with an AMD A8-6410 processor, with UMA graphics, without a touch screen, without
Windows 8

764170-501 System board for use in models with an AMD A8-6410 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

764171-001 System board for use in models with an AMD A8-6410 processor, with UMA graphics, with a touch screen, with
Windows 8

764171-501 System board for use in models with an AMD A8-6410 processor, with UMA graphics, with a touch screen, with a
touch screen, with Windows 8 Standard
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764172-001 System board for use in models with an AMD A4-6210 processor, with UMA graphics, without a touch screen, without
Windows 8

764172-501 System board for use in models with an AMD A4-6210 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

764173-001 System board for use in models with an AMD E2-6110 processor, with UMA graphics, without a touch screen, without
Windows 8

764173-501 System board for use in models with an AMD E2-6110 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

764174-001 System board for use in models with an AMD E1-6010 processor, with UMA graphics, without a touch screen, without
Windows 8

764174-501 System board for use in models with an AMD E1-6010 processor, with UMA graphics, without a touch screen, with
Windows 8 Standard

764175-001 System board for use in models with an AMD A4-6210 processor, with 1 GB of discrete graphics, without a touch
screen, without Windows 8

764175-501 System board for use in models with an AMD A4-6210 processor, with 1 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

764176-001 System board for use in models with an AMD A8-6410 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

764176-501 System board for use in models with an AMD A8-6410 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

764177-001 System board for use in models with an AMD A4-6210 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

764177-501 System board for use in models with an AMD A4-6210 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

764178-001 System board for use in models with an AMD E1-6010 processor, with 2 GB of discrete graphics, without a touch
screen, without Windows 8

764178-501 System board for use in models with an AMD E1-6010 processor, with 2 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

765364-001 System board for use in non-touch screen HP 14, Compaq 14, and HP 240 G3 models with an Intel Core i3-4005U
processor, with UMA graphics, without a touch screen, without Windows 8

765364-501 System board for use in non-touch screen HP 14, Compaq 14, and HP 240 G3 models with an Intel Core i3-4005U
processor, with UMA graphics, without a touch screen, with Windows 8 Standard

765364-601 System board for use in non-touch screen HP 14, Compaq 14, and HP 240 G3 models with an Intel Core i3-4005U
processor, with UMA graphics, without a touch screen, with Windows 8 Professional

766009-001 Display bezel for use with HP 240/246 G3 models

766010-001 Raw display panel for use in HP 240/246 G3 models, non-touch screen

766011-001 System board for use in HP 245 G3 models with an AMD A4-5000 processor and 1 GB of discrete graphics, without
Windows 8

766011-501 System board for use in HP 245 G3 models with an AMD A4-5000 processor and 1 GB of discrete graphics, with
Windows 8 Standard

766011-601 System board for use in HP 245 G3 models with an AMD A4-5000 processor and 1 GB of discrete graphics, with
Windows 8 Professional

766502-001 Heat sink for use in models with an Intel Core 3217U processor and discrete graphics
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766503-001 Heat sink for use in models with an Intel Core 3217U processor and UMA graphics

766504-001 Heat sink for use in models with Intel Pentium and Celeron processors and UMA graphics

766505-001 Rubber feet for use on HP 14 and Compaq 14 models

766567-001 Heat sink assembly for use in models with AMD processors and discrete graphics
(includes replacement thermal materials)

766568-001 Heat sink assembly for use in models with AMD processors and UMA graphics
(includes replacement thermal materials)

766585-001 Hinges for use in models with a touch screen (left and right)

766589-001 Antennas for use in touch screen models (includes wireless antenna cables and transceivers)

766645-001 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
G3 models without Windows 8

766645-501 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
G3 models with Windows 8 Standard

766645-601 System board for use in non-touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
G3 models with Windows 8 Professional

766646-001 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 240/246 G3 models without Windows 8

766646-501 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 240/246 G3 models with Windows 8 Standard

766646-601 System board for use in non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete
graphics in HP 240/246 G3 models with Windows 8 Professional

766896-001 Display enclosure for use in HP 240/246 and HP 245 G3 models

766897-001 Display enclosure for use in HP 240/246 and HP 245 G3 models

766898-001 Base enclosure for use in HP 240/246 and HP 245 G3 (includes left and right rear covers and lock bracket)

766899-001 DVD+/-RW Double-Layer SuperMulti Drive for use in HP 240/246 and 245 G3 models

766900-001 Display bezel for use with HP 245 G3 models

773067-001 Top cover for use in HP 240/246 G3 models (includes touchpad)

773153-001 System board for use in touch screen models with an Intel Core i3-4005U processor and UMA graphics in HP 14 and
Compaq 14 models without Windows 8

773153-501 System board for use in touch screen models with an Intel Core i3-4005U processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Standard

773153-601 System board for use in touch screen models with an Intel Core i3-4005U processor and UMA graphics in HP 14 and
Compaq 14 models with Windows 8 Professional

773154-001 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

773154-501 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

773154-601 System board for use in non-touch screen models with an Intel Core i3-4005U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional
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775629-001 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP
240 G3 models without Windows 8

775629-501 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP
240 G3 models with Windows 8 Standard

775629-601 System board for use in non-touch screen models with an Intel Pentium N3520 processor and UMA graphics in HP
240 G3 models with Windows 8 Professional

775630-001 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 240
G3 models without Windows 8

775630-501 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 240
G3 models with Windows 8 Standard

775630-601 System board for use in non-touch screen models with an Intel Celeron N2815 processor and UMA graphics in HP 240
G3 models with Windows 8 Professional

775631-001 System board for use in HP 240 G3 models without Windows 8 and equipped with an Intel Pentium N3530 processor
and UMA graphics (includes replacement thermal materials)

775631-501 System board for use in HP 240 G3 models with Windows 8 Standard and equipped with an Intel Pentium N3530
processor and UMA graphics (includes replacement thermal materials)

775631-601 System board for use in HP 240 G3 models with Windows 8 Professional and equipped with an Intel Pentium N3530
processor and UMA graphics (includes replacement thermal materials)

775632-001 System board for use in HP 240 G3 models without Windows 8 and equipped with an Intel Celeron N2830 processor
and UMA graphics (includes replacement thermal materials)

775632-501 System board for use in HP 240 G3 models with Windows 8 Standard and equipped with an Intel Celeron N2830
processor and UMA graphics (includes replacement thermal materials)

775632-601 System board for use in HP 240 G3 models with Windows 8 Professional and equipped with an Intel Celeron N2830
processor and UMA graphics (includes replacement thermal materials)

776462-001 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
models without Windows 8

776462-501 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
models with Windows 8 Standard

776462-601 System board for use in touch screen models with an Intel Core i3-3217U processor and UMA graphics in HP 240
models with Windows 8 Professional

776890-001 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14
and Compaq 14 models without Windows 8

776890-501 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Standard

776890-601 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14
and Compaq 14 models with Windows 8 Professional

776931-001 System board for use in models with an AMD E1-6010 processor, with 1 GB of discrete graphics, without a touch
screen, without Windows 8

776931-501 System board for use in models with an AMD E1-6010 processor, with 1 GB of discrete graphics, without a touch
screen, with Windows 8 Standard

778116-001 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

778116-501 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard
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778116-601 System board for use in non-touch screen models with an Intel Core i5-5200U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

778156-001 Raw display panel for use in HP 245 G3 models, touch screen

778188-005 750-GB, 5400-rpm hard drive (HP 14 and Compaq 14 models only; does not include cable or bracket)

778190-005 500-GB, 5400-rpm hard drive (HP 14 and Compaq 14 models only; does not include cable or bracket)

778192-005 1-TB, 5400-rpm hard drive (does not include cable or bracket)

779078-001 System board for use in non-touch screen models with an Intel Core i3-4030U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

779078-501 System board for use in non-touch screen models with an Intel Core i3-4030U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

779078-601 System board for use in non-touch screen models with an Intel Core i3-4030U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

779079-001 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

779079-501 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

779079-601 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

779080-001 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

779080-501 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

779080-601 System board for use in non-touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

784981-001 System board for use in touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete graphics in
HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

784981-501 System board for use in touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete graphics in
HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

784981-601 System board for use in touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete graphics in
HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

788003-001 System board for use in non-touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

788003-501 System board for use in non-touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

788003-601 System board for use in non-touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

788004-001 System board for use in non-touch screen models with an Intel Celeron N2840 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

788004-501 System board for use in non-touch screen models with an Intel Celeron N2840 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

788004-601 System board for use in non-touch screen models with an Intel Celeron N2840 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

Sequential part number listing 41



Spare part
number

Description

788208-001 System board for use in touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

788208-501 System board for use in touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

788208-601 System board for use in touch screen models with an Intel Pentium N3540 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

788210-001 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

788210-501 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

788210-601 System board for use in non-touch screen models with an Intel Core i5-4210U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

790211-001 System board for use in non-touch screen models with an Intel Celeron N2805 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

790211-501 System board for use in non-touch screen models with an Intel Celeron N2805 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

790211-601 System board for use in non-touch screen models with an Intel Celeron N2805 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

790212-001 System board for use in non-touch screen models with an Intel Celeron N2820 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

790212-501 System board for use in non-touch screen models with an Intel Celeron N2820 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

790212-601 System board for use in non-touch screen models with an Intel Celeron N2820 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

790213-001 System board for use in non-touch screen models with an Intel Celeron N2920 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

790213-501 System board for use in non-touch screen models with an Intel Celeron N2920 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

790213-601 System board for use in non-touch screen models with an Intel Celeron N2920 processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

791093-001 System board for use in non-touch screen models with an Intel Core i3-5005U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8

791093-501 System board for use in non-touch screen models with an Intel Core i3-5005U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

791093-601 System board for use in non-touch screen models with an Intel Core i3-5005U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

791094-001 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

791094-501 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

791094-601 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 1 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

791095-001 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8
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Spare part
number

Description

791095-501 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

791095-601 System board for use in non-touch screen models with an Intel Core i3-5005U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional

791096-001 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

791096-501 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

791096-601 System board for use in non-touch screen models with an Intel Core i5-5200U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

791174-001 Display enclosure for use in gray Compaq 14 touch screen models

793101-001 System board for use in HP 245 G3 models with a touch screen and an AMD A6-6310 processor and UMA graphics,
without Windows 8

793101-501 System board for use in HP 245 G3 models with a touch screen and an AMD A6-6310 processor and UMA graphics,
with Windows 8 Standard

793101-601 System board for use in HP 245 G3 models with a touch screen and an AMD A6-6310 processor and UMA graphics,
with Windows 8 Professional

794733-001 System board for use in non-touch screen, GLAN models with an Intel Core i3-4005U processor and UMA graphics in
HP 240 G3 models without Windows 8

794733-501 System board for use in non-touch screen, GLAN models with an Intel Core i3-4005U processor and UMA graphics in
HP 240 G3 models with Windows 8 Standard

794733-601 System board for use in non-touch screen, GLAN models with an Intel Core i3-4005U processor and UMA graphics in
HP 240 G3 models with Windows 8 Professional

795135-001 System board for use in non-touch screen, GLAN models with an Intel Core i5-4210U processor and UMA graphics in
HP 240 G3 models without Windows 8

795135-501 System board for use in non-touch screen, GLAN models with an Intel Core i5-4210U processor and UMA graphics in
HP 240 G3 models with Windows 8 Standard

795135-601 System board for use in non-touch screen, GLAN models with an Intel Core i5-4210U processor and UMA graphics in
HP 240 G3 models with Windows 8 Professional

795136-001 System board for use in non-touch screen, GLAN models with an Intel Core i3-4030U processor and UMA graphics in
HP 240 G3 models without Windows 8

795136-501 System board for use in non-touch screen, GLAN models with an Intel Core i3-4030U processor and UMA graphics in
HP 240 G3 models with Windows 8 Standard

795136-601 System board for use in non-touch screen, GLAN models with an Intel Core i3-4030U processor and UMA graphics in
HP 240 G3 models with Windows 8 Professional

795137-001 System board for use in non-touch screen, GLAN models with an Intel Core i3-3217U processor and UMA graphics in
HP 240 G3 models without Windows 8

795137-501 System board for use in non-touch screen, GLAN models with an Intel Core i3-3217U processor and UMA graphics in
HP 240 G3 models with Windows 8 Standard

795137-601 System board for use in non-touch screen, GLAN models with an Intel Core i3-3217U processor and UMA graphics in
HP 240 G3 models with Windows 8 Professional

801855-001 System board for use in non-touch screen models with an Intel Core i3-5010U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models without Windows 8
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Spare part
number

Description

801855-501 System board for use in non-touch screen models with an Intel Core i3-5010U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Standard

801855-601 System board for use in non-touch screen models with an Intel Core i3-5010U processor and UMA graphics in HP 14,
Compaq 14, and HP 240 G3 models with Windows 8 Professional

801856-001 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models without Windows 8

801856-501 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Standard

801856-601 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 1 GB of discrete
graphics in HP 14 and Compaq 14 models with Windows 8 Professional

801857-001 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models without Windows 8

801857-501 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Standard

801857-601 System board for use in non-touch screen models with an Intel Core i3-5010U processor and 2 GB of discrete
graphics in HP 14, Compaq 14, and HP 240/246 G3 models with Windows 8 Professional
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying
screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care
when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the
reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or
seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases,
avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables
tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure
that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life
expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described in this
section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or non-conductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to avoid
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and
equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.
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● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips
to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be
used at standing workstations and are compatible with most types of shoes or boots. On conductive
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance
between the operator and ground. To be effective, the conductive must be worn in contact with the
skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

Make special note of each screw's size and location during removal and replacement.

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Battery

Description Spare part number

4-cell, 41-Whr, 2.8-Ah Li-ion battery 740715-001

3-cell, 31-Whr, 2.8-Ah Li-ion battery 746641-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

To remove the battery:

1. Position the computer upside down on a flat surface.

2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3. Remove the battery from the computer (3).
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Display subcomponents (bezel, webcam, panel)

This section describes removing display subcomponents that do not require that you remove the entire
display assembly from the computer. You can remove the display bezel, webcam/microphone module, and
display panel while the display assembly is still attached to the computer.

To remove the remaining display subcomponents, you must remove the entire display assembly from the
computer. See Display assembly on page 76 for more information about removing the display assembly in
its entirety.

Description Spare part number

Raw display panel for use in HP 14 and Compaq 14 models without a touch screen 760105-001

Raw display panel for use in HP 240 G3 models without a touch screen 766010-001

Raw display panel for use in HP 245 G3 models with a touch screen 778156-001

Raw display panel for use in HP 14 models, touch screen 760106-001

Raw display panel for use in Compaq 14 models, touch screen 757611-001

Display bezel for use with HP 14 models 757599-001

Display bezel for use with HP 240/246 G3 models 766009-001

Display bezel for use with HP 245 G3 models 766900-001

Display bezel for use with Compaq 14 models 757600-001

Webcam/microphone module, HD 757614-001

Webcam/microphone module, VGA 781623-001

Before removing display subcomponents while the display assembly is still attached to the computer, follow
these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the display bezel, webcam/microphone module, and raw display panel:

1. Position the computer upright with the front toward you, and then open it.

2. Remove the two Mylar covers (1) and two Phillips PM2.0×3.0 screws (2) that secure the bezel to the
display.

3. Flex the inside of the top edge (3), the left and right sides (4), and the bottom edge (5) of the display
bezel until the bezel disengages from the display enclosure.
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4. Remove the display bezel.

5. To remove the webcam/microphone module:

a. Position the display assembly with the top edge toward you.

b. Lift to disengage the adhesive that secures the webcam/microphone module to the display, and
then lift the module enough to access the cable connection on the module (1).

c. Disconnect the cable (2) from the module.

6. To remove the display panel:

a. Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the enclosure.
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b. Rotate the display panel onto the keyboard to gain access to the display cable connection on the
back of the panel (1).

c. On the back of the display panel, release the adhesive strip (2) that secures the display panel cable
to the display panel, and then disconnect the cable (3).

Reverse this procedure to reassemble and install the display bezel, webcam/microphone module, and display
panel.
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Optical drive

Description Spare part number

DVD+/-RW Double-Layer SuperMulti Drive for use in HP 14 and Compaq 14 models 757606-001

DVD+/-RW Double-Layer SuperMulti Drive for use in HP 240/246 and HP 245 G3 models 766899-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the optical drive:

1. Remove the Phillips PM2.5×8.0 screw (1) that secures the optical drive to the computer.

2. Remove the optical drive (2) by sliding it out of the optical drive bay.

3. If it is necessary to replace the optical drive bracket on the rear of the optical drive, position the optical
drive with the rear panel toward you.

4. Remove the two Phillips PM2.0×3.0 screws (1) that secure the bracket to the optical drive.
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5. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Service cover

Description Spare part number

Service cover 758616-001

Before removing the service cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the service cover:

1. Loosen the Phillips service cover screw (1).

2. Lift up and remove the service cover (2).

Reverse this procedure to install the service cover.
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Memory module

Description Spare part number

8-GB (PC3L, 12800, 1600-MHz) 693374-001

4-GB (PC3L, 12800, 1600-MHz) 691740-001

2-GB (PC3L, 12800, 1600-MHz) 691739-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the service cover (see Service cover on page 55).

To remove a memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.

56 Chapter 4   Removal and replacement procedures



Keyboard

Description Spare part number

Keyboard for use in the United States 757922-001

Keyboard for use in the United Kingdom 757922-031

Keyboard for use in France 757922-051

Keyboard for use in Spain 757922-071

Keyboard for use in Portugal 757922-131

Keyboard for use in Turkey 757922-141

Keyboard for use in Latin America 757922-161

Keyboard for use in Saudi Arabia 757922-171

Keyboard for use in Brazil 757922-201

Keyboard for use in Russia 757922-251

Keyboard for use in Thailand 757922-281

Keyboard for use in Japan 757922-291

Keyboard for use in Taiwan 757922-AB1

Keyboard for use in South Korea 757922-AD1

Keyboard for use in the Netherlands 757922-B31

Keyboard for use in Israel 757922-BB1

Keyboard for use in Switzerland 757922-BG1

Keyboard for use in French Canada 757922-DB1

Keyboard for use in Denmark, Finland, and Norway 757922-DH1

Keyboard for use in the Czech Republic and Slovakia 757922-FL1

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the keyboard:

1. Position the computer upside down with the front toward you.
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2. Remove the two Phillips PM2.5×5.0 screws that secure the keyboard to the computer.

3. Position the computer upright with the front toward you.

4. Lift to rotate up the top of the keyboard (1), and then lift the keyboard (2) to disengage it from the
computer.

NOTE: You may need to use a flat tool to pry up under the top of the keyboard to disengage it.

58 Chapter 4   Removal and replacement procedures



5. Rotate the keyboard over onto the palm rest (1), and the lift the ZIF connector (2) and disconnect the
keyboard cable from the system board (3).

Reverse this procedure to install the keyboard.
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Top cover

NOTE: The top cover spare part kit includes the TouchPad.

Description Spare part number

Top cover for use in black HP 14 and Compaq 14 models (includes touchpad) 757613-001

Top cover for use in gray HP 14 and Compaq 14 models (includes touchpad) 758618-001

Top cover for use in white HP 14 and Compaq 14 models (includes touchpad) 758911-001

Top cover for use in red HP 14 and Compaq 14 models (includes touchpad) 758912-001

Top cover for use in blue HP 14 and Compaq 14 models (includes touchpad) 758913-001

Top cover for use in silver HP 14 and Compaq 14 models (includes touchpad) 760247-001

Top cover for use in HP 245 G3 models 758618-001

Top cover for use in HP 240/246 G3 models 773067-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

To remove the top cover:

1. Position the computer upside down.
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2. Remove the nine Phillips PM2.5×8.0 screws that secure the top cover to the computer.
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3. Remove the rear covers from the computer.

The rear covers are included in the base enclosure kit, spare part number 757598-001 for HP 14 and
Compaq 14 models, 766898-001 for HP 240/246 and HP 245 G3 models.

4. Remove the two Phillips broadhead PM2.0×2.0 screws from the optical drive bay that secure the top
cover to the computer.

5. Position the computer upright with the front toward you.
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6. Disconnect the power button board cable (1) and the touchpad button board cable (2).

7. Remove the three Phillips PM2.5×4.0 screws that secure the top cover to the computer.

8. Lift the rear edge of the top cover (1) until it disengage from the base enclosure.

NOTE: The top cover may be very tightly secured to the computer.
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9. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (includes cable) 757607-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the power button board:

1. Position the top cover upside down.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the power button board to the top cover.

3. Lift the board and cable up and remove from the top cover (2).

Reverse this procedure to install the power button board and cable.
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TouchPad button board

Description Spare part number

TouchPad button board (includes cables) 757609-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the TouchPad button board:

1. Position the top cover upside down with the front toward you.

2. Lift the ZIF connector (1), and then disconnect the touchpad board cable from the touchpad (2).

3. Remove the two Phillips PM2.0×3.0 screws (3) that secure the TouchPad button board to the top cover.

4. Remove the TouchPad button board and cable (4).

Reverse this procedure to install the TouchPad button board and cable.
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USB board

Description Spare part number

USB board (includes cable) 757608-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the USB board:

1. Position the computer upright.

2. Lift the ZIF connector (1), and then disconnect the USB board cable from the system board (2).

3. Remove the Phillips PM2.5×3.0 screw (3) that secures the USB board to the base enclosure.

4. Remove the USB board (4).

Reverse this procedure to install the USB board.

Component replacement procedures 67



Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket.

Description Spare part number

1-GB, 5400-rpm 778192-005

750-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778190-005

750-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 634250-005

500-GB, 5400-rpm (HP 14 and Compaq 14 models only) 778188-005

500-GB, 5400-rpm (HP 240/246 and HP 245 G3 models only) 669299-005

500-GB, 5400-rpm, 7 mm (HP 240/246 G3 models only) 683802-005

Hard Drive Hardware Kit (includes bracket and screws) 758615-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● USB board (see USB board on page 67

To remove the hard drive:

1. Remove the right speaker by removing the two Phillips broadhead PM2.0×2.0 screws (1), removing the
speaker cable from the clips in the chassis (2), and lifting the speaker from the base enclosure (3).
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2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the hard drive to the computer.

3. Slide the hard drive to disengage it from the connector (2).

4. Lift the hard drive from the computer (3).

5. To remove the hard drive bracket, remove the two Phillips PM3.0×4.0 screws (1) that secure the bracket
to the hard drive.
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6. Remove the hard drive bracket from the hard drive (2).

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-005

Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter 690020-005

Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter for use in Brazil 712639-205

Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-005

Realtek RT8723BE 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter 753077-005

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in your
country or region. If you replace the module and then receive a warning message, remove the module to
restore device functionality, and then contact support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The #1 WLAN antenna cable is connected to the WLAN module Main terminal. The #2 WLAN
antenna cable is connected to the WLAN module Aux terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board. (The
WLAN module tilts up.)
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3. Remove the WLAN module by pulling the module away from the connector (3).

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Power connector cable

Description Spare part number

Power connector cable 760104-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the power connector cable:

1. Position the computer upright.

2. Disconnect the power connector cable (1) from the system board.

3. Remove the power connector cable (2).

Reverse this procedure to install the power connector cable.

Component replacement procedures 73



Fan

Description Spare part number

Fan 753894-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3.0 in) of clearance on the left side of the
computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

To remove the fan:

1. Position the computer upright and open it.

2. Disconnect the fan cable (1) from the bottom of the system board.

3. Remove the two Phillips PM1.0×4.0 screws (2) that secure the fan to the computer.
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4. Remove the fan from the computer (3).

Reverse this procedure to install the fan.
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Display assembly

This section describes removing the display assembly in its entirety and disassembling all the display
subcomponents.

If you only need to remove the display bezel, webcam/microphone module, or display panel, you do not need
to remove the entire display assembly from the computer. See Display subcomponents (bezel, webcam,
panel) on page 50 for more information about removing the display subcomponents that do not require that
you remove the entire display assembly from the computer.

Description Spare part number

Display assembly (35.6-cm [14.0-in] HD, anti-glare, touchscreen, for use in black HP 14 models 747121-001

Raw display panel for use in HP 14 and Compaq 14 models 760105-001

Antennas for use in non-touch screen models (includes wireless antenna cables and transceivers) 757596-001

Antennas for use in touch screen models (includes wireless antenna cables and transceivers) 766589-001

Display bezel for use in HP 14 models 757599-001

Display bezel for use with HP 240/246 G3 models 766009-001

Display bezel for use with HP 245 G3 models 766900-001

Display bezel for use in Compaq 15 models 757600-001

Display cable for use in non-touch screen models (includes display panel cable and webcam/microphone cable) 757601-001

Display cable for use in touch screen models (includes display panel cable and webcam/microphone cable) 757597-001

Display enclosure for use in silver HP 14 models without a touch screen 757604-001

Display enclosure for use in HP 240/246 G3 models without a touch screen 766897-001

Display enclosure for use in black HP 14 models without a touch screen 758603-001

Display enclosure for use in white HP 14 models without a touch screen 758604-001

Display enclosure for use in red HP 14 models without a touch screen 758605-001

Display enclosure for use in blue HP 14 models without a touch screen 758606-001

Display enclosure for use in gray HP 14 models without a touch screen 760102-001

Display enclosure for use in gray HP 14 models with a touch screen 760103-001

Display enclosure for use in gray Compaq 14 models without a touch screen 758607-001

Display enclosure for use in gray Compaq 14 models with a touch screen 791174-001

Display enclosure for use in black HP 14 and Compaq 14 models with a touch screen 758608-001

Display enclosure for use in white HP 14 and Compaq 14 models with a touch screen 758609-001

Display enclosure for use in red HP 14 and Compaq 14 models with a touch screen 758610-001

Display enclosure for use in blue HP 14 and Compaq 14 models with a touch screen 758611-001

Display enclosure for use in silver HP 14 and Compaq 14 models with a touch screen 760246-001

Hinges for use in models without a touch screen (left and right) 757605-001

Hinges for use in models with a touch screen (left and right) 766585-001
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Description Spare part number

Webcam/microphone module, HD 757614-001

Webcam/microphone module, VGA 781623-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● Fan (see Fan on page 74)

To remove the display assembly:

1. Disconnect the display panel cable from the system board (1) and remove the cable from the routing
channel in the left side of the base enclosure.

2. Release the wireless antenna cables from the WLAN module (2) and remove the cables from the routing
channel in the right side of the base enclosure.

CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other computer components.
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3. Remove the six Phillips PM2.5×4.0 screws (1) (three from each hinge) that secure the display assembly
to the computer.

4. Remove the display assembly (2).

If it is necessary to replace any of the display assembly subcomponents:

1. To remove the display bezel:

a. Remove the two Mylar covers (1) and two Phillips PM2.0×3.0 screws (2) that secure the bezel to
the display.

b. Flex the inside of the top edge (3), the left and right sides (4), and the bottom edge (5) of the
display bezel until the bezel disengages from the display enclosure.
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c. Remove the display bezel.

NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.

2. To remove the webcam/microphone module:

a. Position the display assembly with the top edge toward you.

b. Disconnect the cable (1) from the module.

c. Remove the webcam/microphone module (2). (The module is attached to the display enclosure
with double-sided tape.)

3. To remove the display panel:

a. Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the enclosure.
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NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.

b. Rotate the display panel onto the keyboard to gain access to the display cable connection on the
back of the panel (1).

c. On the back of the display panel, release the adhesive strip (2) that secures the display panel cable
to the display panel, and then disconnect the cable (3).

NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.

4. To remove the display hinges:
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a. Remove the six broadhead Phillips PM2.5×2.5 screws (1) and the two Phillips PM2.0×2.5 screws
(2) that secure the display hinges to the display enclosure.

b. Remove the display hinges (3).

5. To remove the wireless antenna cables and transceivers, release the wireless antenna cables from the
clips built into the display enclosure (1), and then lift the antenna cables from the display enclosure (2).

NOTE: The number of antenna cables may vary.
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6. To remove the display/webcam cable, remove the cable from the clips built into the display enclosure
(1), and then remove the cable from the display enclosure (2).

NOTE: If replacing the display enclosure, be sure that the subcomponents (including the webcam/
microphone module, the antenna receivers, and all associated cables and hardware) are transferred to
the new enclosure.

Reverse this procedure to reassemble and install the display assembly.
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System board

NOTE: The system board spare part kit includes replacement thermal materials.

All Intel system boards use the following part numbers:

xxxxxx-001: Without the Windows operating system

xxxxxx-501: Windows 8.1 Standard

xxxxxx-601: Windows 8.1 Professional

Description Spare part number

HP 14, Compaq 14, and HP 240/246 G3 models with Intel processors:

NOTE: HP 246 G3 models offer only discrete graphics.

 

Non-touch screen models with an Intel Core i5-5200U processor and 2 GB of discrete graphics 762240-xxx

Non-touch screen models with an Intel Core i3-5010U processor and 2 GB of discrete graphics 801857-xxx

Non-touch screen models with an Intel Core i3-5010U processor and UMA graphics 801855-xxx

Non-touch screen models with an Intel Core i3-5005U processor and 2 GB of discrete graphics 791095-xxx

Non-touch screen models with an Intel Core i3-5005U processor and 1 GB of discrete graphics 791094-xxx

Non-touch screen models with an Intel Core i3-5005U processor and UMA graphics 791093-xxx

Non-touch screen models with an Intel Core i5-4210U processor and UMA graphics 755835-xxx

Non-touch screen models with an Intel Core i3-4030U processor and 2 GB of discrete graphics 779080-xxx

Non-touch screen models with an Intel Core i3-4030U processor and 1 GB of discrete graphics 779079-xxx

Non-touch screen models with an Intel Core i3-4030U processor and UMA graphics 779078-xxx

Non-touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics 778116-xxx

Non-touch screen models with an Intel Core i3-4010U processor and UMA graphics 755831-xxx

Non-touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics 755832-xxx

Non-touch screen models with an Intel Core i3-4005U processor and UMA graphics 765364-xxx

Non-touch screen models with an Intel Pentium N3540 processor and UMA graphics 788003-xxx

Touch screen models with an Intel Pentium N3540 processor and UMA graphics 788208-xxx

Non-touch screen models with an Intel Celeron N2920 processor and UMA graphics 790213-xxx

Non-touch screen models with an Intel Celeron N2840 processor and UMA graphics 788004-xxx

Non-touch screen models with an Intel Celeron N2820 processor and UMA graphics: 790212-xxx

Non-touch screen models with an Intel Celeron N2805 processor and UMA graphics: 790211-xxx

HP 14 and Compaq 14 models with Intel processors:

Non-touch screen models with an Intel Core i5-5200U processor and 1 GB of discrete graphics 791096-xxx

Non-touch screen models with an Intel Core i5-5200U processor and UMA graphics 776890-xxx

Non-touch screen models with an Intel Core i3-5010U processor and 1 GB of discrete graphics 801856-xxx

Non-touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics 755834-xxx
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Description Spare part number

Touch screen models with an Intel Core i5-4210U processor and 2 GB of discrete graphics 757610-xxx

Non-touch screen models with an Intel Core i5-4210U processor and 1 GB of discrete graphics 788210-xxx

Touch screen models with an Intel Core i5-4030U processor and 2 GB of discrete graphics 784981-xxx

Touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics 758614-xxx

Non-touch screen models with an Intel Core i3-4010U processor and 2 GB of discrete graphics 755833-xxx

Touch screen models with an Intel Core i3-4010U processor and 1 GB of discrete graphics: 758613-xxx

Touch screen models with an Intel Core i3-4005U processor and UMA graphics 773153-xxx

Non-touch screen models with an Intel Core i3-4005U processor and 1 GB of discrete graphics 773154-xxx

Touch screen models with an Intel Core i3-4005U processor and 2 GB of discrete graphics 755836-xxx

Non-touch screen models with an Intel Core i3-3217U processor and UMA graphics 755829-xxx

Non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete graphics 755830-xxx

Touch screen models with an Intel Core i3-3217U processor and UMA graphics 762239-xxx

Touch screen models with an Intel Pentium N3530 processor and UMA graphics 764051-xxx

Non-touch screen models with an Intel Pentium N3520 processor and UMA graphics 755837-xxx

Non-touch screen models with an Intel Celeron N2830 processor and UMA graphics 764050-xxx

Non-touch screen models with an Intel Celeron N2815 processor and UMA graphics 755838-xxx

HP 240/246 G3 models:

NOTE: HP 246 G3 models offer only discrete graphics.

Non-touch screen models with an Intel Pentium N3530 processor and UMA graphics 775631-xxx

Non-touch screen, GLAN models with an Intel Core i5-4210U processor and UMA graphics 795135-xxx

Non-touch screen, GLAN models with an Intel Core i3-4030 processor and UMA graphics 795136-xxx

Non-touch screen, GLAN models with an Intel Core i5-4005U processor and UMA graphics 794733-xxx

Non-touch screen models with an Intel Core i3-3217U processor and 1 GB of discrete graphics 766646-xxx

Non-touch screen models with an Intel Core i3-3217U processor and UMA graphics 766645-xxx

Non-touch screen, GLAN models with an Intel Core i3-3217U processor and UMA graphics: 795137-xxx

Touch screen models with an Intel Core i3-3217U processor and UMA graphics 776462-xxx

Non-touch screen models with an Intel Pentium N3530 processor and UMA graphics 775629-xxx

Non-touch screen models with an Intel Celeron N2830 processor and UMA graphics 775632-xxx

Non-touch screen models with an Intel Celeron N2815 processor and UMA graphics 775630-xxx

HP 14, Compaq 14, and HP 245 G3 models with AMD processors  

AMD A8-6410 processor with UMA graphics without a touch screen

● Without Windows 8 764170-001

● Windows 8 Standard 764170-501

AMD A8-6410 processor with UMA graphics memory and a touch screen
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Description Spare part number

● Without Windows 8 764171-001

● Windows 8 Standard 764171-501

AMD A8-6410 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 764176-001

● Windows 8 Standard 764176-501

AMD A4-6210 processor with UMA graphics without a touch screen

● Without Windows 8 764172-001

● Windows 8 Standard 764172-501

AMD A4-6210 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 764171-001

● Windows 8 Standard 764171-501

AMD A4-6210 processor with 1 GB of discrete graphics memory without a touch screen

● Without Windows 8 764175-001

● Windows 8 Standard 764175-501

AMD E2-6110 processor with UMA graphics without a touch screen

● Without Windows 8 764173-001

● Windows 8 Standard 764173-501

AMD E1-6010 processor with UMA graphics without a touch screen

● Without Windows 8 764174-001

● Windows 8 Standard 764174-501

AMD E1-6010 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 764178-001

● Windows 8 Standard 764178-501

AMD E1-6010 processor with 1 GB of discrete graphics memory without a touch screen

● Without Windows 8 776931-001

● Windows 8 Standard 776931-501

AMD A6-5200 processor with UMA graphics without a touch screen

● Without Windows 8 762422-001

● Windows 8 Standard 762422-501

● Windows 8 Professional 762422-601

AMD A6-5200 processor with UMA graphics memory and a touch screen

● Without Windows 8 762423-001

● Windows 8 Standard 762423-501

AMD A4-5050 processor with UMA graphics without a touch screen
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Description Spare part number

● Without Windows 8 762425-001

● Windows 8 Standard 762425-501

AMD A4-5050 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 762430-001

● Windows 8 Standard 762430-501

AMD A4-5050 processor with 1 GB of discrete graphics memory without a touch screen

● Without Windows 8 762428-001

● Windows 8 Standard 762428-501

AMD A4-5000 processor with UMA graphics without a touch screen

● Without Windows 8 762427-001

● Windows 8 Standard 762427-501

● Windows 8 Professional 762427-601

AMD A4-5000 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 762431-001

● Windows 8 Standard 762431-501

AMD E2-3800 processor with UMA graphics without a touch screen

● Without Windows 8 762421-001

● Windows 8 Standard 762421-501

● Windows 8 Professional 762421-601

AMD E1-2150 processor with UMA graphics without a touch screen

● Without Windows 8 762426-001

● Windows 8 Standard 762426-501

AMD E1-2100 processor with UMA graphics without a touch screen

● Without Windows 8 762424-001

● Windows 8 Standard 762424-501

● Windows 8 Professional 762424-601

AMD E1-2100 processor with 2 GB of discrete graphics memory without a touch screen

● Without Windows 8 762429-001

● Windows 8 Standard 762429-501

HP 245 G3 models:  

AMD A4-5000 processor and 1 GB of discrete graphics memory without a touch screen:

● Without Windows 8 766011-001

● Windows 8 Standard 766011-501

● Windows 8 Professional 766011-601
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Description Spare part number

AMD A6-6310 processor and UMA graphics memory with a touch screen:  

● Without Windows 8 793101-001

● Windows 8 Standard 793101-501

● Windows 8 Professional 793101-601

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● USB board (see USB board on page 67)

● Hard drive (see Hard drive on page 68)

NOTE: When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 56)

● Heat sink assembly (see Heat sink assembly on page 91)

● WLAN module (see WLAN module on page 71)

To remove the system board:

1. Position the computer upright, and then disconnect the following cables from the system board:

(1): Power connector cable

(2): Display cable

(3): Speaker cable
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2. Remove the three Phillips PM2.5×4.0 screws (1) that secure the system board to the computer.

3. Lift the right side of the system board (2), and then pull the board away from the computer to remove
it.

Reverse this procedure to install the system board.
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Speakers

Description Spare part number

Speakers (includes left and right speakers and cable) 757612-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● WLAN module (see WLAN module on page 71)

● USB board (see USB board on page 67

● Hard drive (see Hard drive on page 68

● System board (see System board on page 83

To remove the speakers:

1. The right speaker was removed when removing the hard drive (Hard drive on page 68).

2. Remove the two Phillips broadhead PM2.0×2.0 screws (1) that secure the left speaker to the computer.
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3. Lift the speakers from the base enclosure (2).

NOTE: Note the rubber gaskets around each screw. When installing the speakers, make sure the
gaskets are installed correctly.

Reverse this procedure to install the speakers.
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Heat sink assembly

NOTE: The heat sink assembly spare part kit includes replacement thermal materials.

Description Spare part number

Heat sink for use in models with Intel processors and discrete graphics 757602-001

Heat sink for use in models with Intel processors and UMA graphics 757603-001

Heat sink for use in models with Intel Pentium and Celeron processors and UMA graphics 766504-001

Heat sink for use in models with an Intel Core i3-3217U processor and UMA graphics 766503-001

Heat sink for use in models with an Intel Core i3-3217U processor and discrete graphics 766502-001

Heat sink for use in models with AMD processors and discrete graphics 766567-001

Heat sink for use in models with AMD processors and UMA graphics 766568-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3.0 in) of clearance on the left side of the
computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the computer.

Before removing the heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● WLAN module (see WLAN module on page 71)

● USB board (see USB board on page 67

● Hard drive (see Hard drive on page 68

● System board (see System board on page 83)

To remove the heat sink assembly:

1. Position the system board upside down.

2. Remove the PM2.0×3.0 screws (1) that secure the heat sink assembly to the system board.
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3. Remove the heat sink assembly (2) from the system board.

Discrete heat sink:

UMA heat sink:
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The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board
components each time the heat sink is removed. Replacement thermal material is included with the heat
sink, processor, and system board spare part kits.

The following illustrations show replacement thermal material locations.

● Discrete graphics: Thermal paste is used on the processor and associated heat sink area (1)(2), as well
as the graphics chip and associated heat sink area (3)(4).

● UMA graphics: Thermal paste is used on the processor (1) and the heat sink (2).

Reverse this procedure to reassemble and install the heat sink assembly.
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RTC battery

Description Spare part number

RTC battery 759981-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

● Service cover (see Service cover on page 55)

● Keyboard (see Keyboard on page 57)

● Top cover (see Top cover on page 60)

● WLAN module (see WLAN module on page 71)

● USB board (see USB board on page 67

● Hard drive (see Hard drive on page 68

● System board (see System board on page 83)

To remove the RTC battery:

1. Position the system board upside down.
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2. Using a thin tool or screwdriver, disengage the battery from the socket (1), and then remove the battery
(2).

Reverse this procedure to install the RTC battery.
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5 Using Setup Utility (BIOS) and HP PC
Hardware Diagnostics (UEFI) in Windows 8

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS)
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

Starting Setup Utility (BIOS)
To start Setup Utility (BIOS), turn on or restart the computer, quickly press esc, and then press f10.

NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer
from operating properly.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Setup Utility (BIOS).

1. Start Setup Utility (BIOS) (see Starting Setup Utility (BIOS) on page 97).

2. Use the arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the arrow keys to select Exit, select Exit
Discarding Changes, and then press enter.

4. Select Yes.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type hp support assistant, and then select the HP Support Assistant
app.

2. Click Updates and tune-ups, and then click Check for HP updates now.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. If the update is more recent than your BIOS, make a note of the date, name, or
other identifier. You may need this information to locate the update later, after it has been
downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:

1. From the Start screen, type file, and then select File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside
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the operating system so that it can isolate hardware failures from issues that are caused by the operating
system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 99.

b. Hard drive

c. BIOS

2. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you
want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.

Using HP PC Hardware Diagnostics (UEFI) 99

http://www.hp.com/go/techcenter/pcdiags
http://www.hp.com


100 Chapter 5   Using Setup Utility (BIOS) and HP PC Hardware Diagnostics (UEFI) in Windows 8



6 Using Setup Utility (BIOS) and System
Diagnostics in Windows 7

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS)
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

Starting Setup Utility (BIOS)
To start Setup Utility (BIOS), follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility (BIOS).

Information about how to navigate in Setup Utility (BIOS) is located at the bottom of the screen.

NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer
from operating properly.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if
you are already in Windows) or by using Setup Utility (BIOS).

1. Start Setup Utility (BIOS).

2. Use the arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the tab key and the arrow keys to select
Exit > Exit Discarding Changes, and then press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to
download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your computer.
Make a note of the date, name, or other identifier. You may need this information to locate the
update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded.
You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside
the operating system so that it can isolate hardware failures from issues that are caused by the operating
system or other software components.

102 Chapter 6   Using Setup Utility (BIOS) and System Diagnostics in Windows 7



To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 103.

b. Hard drive

c. BIOS

2. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you
want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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7 Computer Setup (BIOS) and HP PC Hardware
Diagnostics (UEFI) in SUSE Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if
USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow
the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc
key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and
then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to
download.

3. Click the option for software and driver downloads, type your computer model number in the product
box, and then press enter. Follow the on-screen instructions to identify your computer and access the
BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside
the operating system so that it can isolate hardware failures from issues that are caused by the operating
system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press F2.

The BIOS searches two places for the diagnostic tools, in the following order:

a. Connected USB drive
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NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 108.

b. BIOS

2. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you
want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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8 Specifications

Computer specifications

 Metric U.S.

Dimensions (touch models)

Depth 244 mm 9.61 in

Width 345 mm 13.58 in

Height 25.3 mm 1.00 in

Weight (with 3 cell battery) 1910 g 4.21 lb

Input power

Operating voltage and current 18.5 V dc @ 3.5 A or 19.5 V dc @ 3.33 A – 65 W

19 V dc @ 4.74 A or 19.5 V dc @ 4.62 A – 90 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range of
temperatures.

Computer specifications 109



35.6-cm (14.0-in) display specifications

 Metric U.S.

Dimensions

Height 17.6 cm 6.93 in

Width 31.2 cm 12.28 in

Diagonal 35.7 cm 14.06 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 1-TB* 750-GB*

(9.5 mm)

500-GB*

(7.0 mm)

Dimensions

Height 9.5 mm 9.5 mm 7.0 mm or 9.5 mm

Length 100.4 mm 100.4 mm 100.6 mm

Width 69.9 mm 69.9 mm 70.1 mm

Weight 115.0 g 115.0 g 92.0 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 300 MB/sec 300 MB/sec 300 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.4 ms 1.5 ms 3 ms

Average (read/write) 10 ms 11 ms 13 ms

Maximum 12 ms 14 ms 24 ms

Logical blocks 1,938,921,461 1,465,149,168 1,048,576,000

Disk rotational speed 5400 rpm 5400 rpm 5400 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW SuperMulti DL Drive specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-
ROM XA, MIXED MODE CD, CD-I, CD-I Bridge (Photo-
CD, Video CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW,
DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 μm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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9 Backing up, restoring, and recovering in
Windows 8

This chapter provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

Creating recovery media and backups
1. After you successfully set up the computer, create HP Recovery media. This step creates a backup of the

HP Recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

HP Recovery media you create will provide the following recovery options:

● System Recovery—Reinstalls the original operating system and the programs that were installed
at the factory.

● Minimized Image Recovery—Reinstalls the operating system and all hardware-related drivers and
software, but not other software applications.

● Factory Reset—Restores the computer to its original factory state by deleting all information
from the hard drive and re-creating the partitions. Then it reinstalls the operating system and the
software that was installed at the factory.

See Creating HP Recovery media on page 113.

2. Use the Windows tools to create system restore points and create backups of personal information. For
more information and steps, see Help and Support. From the Start screen, type help, and then select
Help and Support.

Creating HP Recovery media

HP Recovery Manager is a software program that offers a way to create recovery media after you
successfully set up the computer. HP Recovery media can be used to perform system recovery if the hard
drive becomes corrupted. System recovery reinstalls the original operating system and the software
programs installed at the factory, and then configures the settings for the programs. HP Recovery media can
also be used to customize the system or restore the factory image if you replace the hard drive.

● Only one set of HP Recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

● HP Recovery Manager examines the computer and determines the required storage capacity for the
blank USB flash drive or the number of blank DVD discs that will be required.

● To create recovery discs, your computer must have an optical drive with DVD writer capability, and you
must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable
discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) discs; they are not
compatible with HP Recovery Manager software. Or instead you can use a high-quality blank USB flash
drive. 
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● If your computer does not include an integrated optical drive with DVD writer capability, but you would
like to create DVD recovery media, you can use an external optical drive (purchased separately) to
create recovery discs, or you can obtain recovery discs for your computer from support. See the
Worldwide Telephone Numbers booklet included with the computer. You can also find contact
information from the HP website. Go to http://www.hp.com/support, select your country or region, and
follow the on-screen instructions. If you use an external optical drive, it must be connected directly to a
USB port on the computer; the drive cannot be connected to a USB port on an external device, such as a
USB hub.

● Be sure that the computer is connected to AC power before you begin creating the recovery media.

● The creation process can take up to an hour or more. Do not interrupt the creation process.

● If necessary, you can exit the program before you have finished creating all of the recovery DVDs. HP
Recovery Manager will finish burning the current DVD. The next time you start HP Recovery Manager,
you will be prompted to continue, and the remaining discs will be burned.

To create HP Recovery media:

IMPORTANT: For tablets, connect to the keyboard dock before beginning these steps (select models only).

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Recovery Media Creation, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 115.

Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:

● Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information and steps, see Help and Support. From the Start
screen, type help, and then select Help and Support. 

● If you need to correct a problem with a preinstalled application or driver, use the Drivers and
Applications Reinstall option of HP Recovery Manager to reinstall the individual application or driver.

From the Start screen, type recovery, select HP Recovery Manager, select Drivers and Applications
Reinstall, and then follow the on-screen instructions.

● If you want to reset your computer using a minimized image, you can choose the HP Minimized Image
Recovery option from the HP Recovery partition (select models only) or HP Recovery media. Minimized
Image Recovery installs only drivers and hardware-enabling applications. Other applications included in
the image continue to be available for installation through the Drivers and Applications Reinstall option
in HP Recovery Manager.

For more information, see Recovering using HP Recovery Manager on page 115.

● If you want to recover the computer's original factory partitioning and content, you can choose the
System Recovery option from the HP Recovery partition (select models only) or use the HP Recovery
media that you have created. For more information, see Recovering using HP Recovery Manager
on page 115. If you have not already created recovery media, see Creating HP Recovery media
on page 113.
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● If you have replaced the hard drive, you can use the Factory Reset option of HP Recovery media to
restore the factory image to the replacement drive. For more information, see Recovering using HP
Recovery Manager on page 115.

● If you wish to remove the recovery partition to reclaim hard drive space, HP Recovery Manager offers
the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition on page 116.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you created or by using the HP Recovery partition (select models only). If you have
not already created recovery media, see Creating HP Recovery media on page 113.

Using HP Recovery media, you can choose from one of the following recovery options:

● System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

● Minimized Image Recovery (select models only)—Reinstalls the operating system and all hardware-
related drivers and software, but not other software applications.

● Factory Reset—Restores the computer to its original factory state by deleting all information from the
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that
was installed at the factory.

The HP Recovery partition (select models only) allows System Recovery and Minimized Image Recovery.

What you need to know

● HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's website
or reinstall the software from the media provided by the manufacturer.

● Recovery through HP Recovery Manager should be used as a final attempt to correct computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media on page 113.

● To use the Factory Reset option, you must use HP Recovery media. If you have not already created
recovery media, see Creating HP Recovery media on page 113.

● If the HP Recovery media does not work, you can obtain recovery media for your system from support.
See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact
information from the HP website. Go to http://www.hp.com/support, select your country or region, and
follow the on-screen instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you wish to retain.

Using the HP Recovery partition (select models only)

The HP Recovery partition (select models only) allows you to perform a system recovery or minimized image
recovery without the need for recovery discs or a recovery USB flash drive. This type of recovery can only be
used if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

IMPORTANT: For tablets, connect to the keyboard dock before beginning these steps (select models only).
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1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Choose your keyboard layout.

3. Select Troubleshoot from the boot options menu.

4. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media that you created, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 116.

3. Follow the on-screen instructions.

Changing the computer boot order

If computer does not restart in HP Recovery Manager, you can change the computer boot order, which is the
order of devices listed in BIOS where the computer looks for startup information. You can change the
selection for an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media you created.

2. Restart the computer, quickly press esc, and then press f9 for boot options.

3. Select the optical drive or USB flash drive you want to boot from.

4. Follow the on-screen instructions.

Removing the HP Recovery partition

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

IMPORTANT: After you remove the HP Recovery partition, you can no longer use the Windows Refresh
option, the Windows option to remove everything and reinstall Windows, or the HP Recovery Manager option.
So before you remove the Recovery partition, create HP Recovery media; see Creating HP Recovery media
on page 113.

Follow these steps to remove the HP Recovery partition:

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.

116 Chapter 9   Backing up, restoring, and recovering in Windows 8



10 Backing up, restoring, and recovering in
Windows 7

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and retrieve it if ever needed.

Creating backups
1. Use HP Recovery Manager to create recovery media immediately after you set up the working

computer.

2. As you add hardware and software programs, create system restore points.

3. As you add photos, video, music, and other personal files, create a backup of your system and personal
information.

Creating recovery media to recover the original system

After you successfully set up the computer, you should create recovery discs or a recovery flash drive using
HP Recovery Manager. You will need these recovery discs or recovery flash drive to perform a system
recovery should the hard drive become corrupted. A system recovery reinstalls the original operating system,
and then configures the settings for the default programs.

What you need to know

● Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in
a safe place.

● HP Recovery Manager examines the computer and determines the required storage capacity for the
flash drive or the number of blank DVD discs that will be required.

Use DVD-R, DVD+R, DVD-R DL, DVD+R DL discs or a flash drive. Do not use rewriteable discs such as CD
±RW, DVD±RW, double-layer DVD±RW, and BD-RE (rewritable Blu-ray) discs; they are not compatible
with HP Recovery Manager software.

● If your computer does not include an integrated optical drive, you can use an optional external optical
drive (purchased separately) to create recovery discs, or you can obtain recovery discs for your
computer from the HP website. If you use an external optical drive, it must be connected directly to a
USB port on the computer, not to a USB port on an external device, such as a USB hub.

● Be sure that the computer is connected to AC power before you begin creating the recovery media.

● The creation process can take up to an hour or more. Do not interrupt the creation process.

● Store the recovery media in a safe location, separate from the computer.

● If necessary, you can exit the program before you have finished creating the recovery media. The next
time you open HP Recovery Manager, you will be prompted to continue the process.
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Creating the recovery media

1. Select Start and type recovery in the search field. Select Recovery Manager from the list. Allow the
action to continue, if prompted.

2. Click Recovery Media Creation.

3. Follow the on-screen instructions to continue.

To recover, see Recovering the original system using HP Recovery Manager on page 120.

Creating system restore points

A system restore point is a snapshot of certain hard drive contents saved by Windows System Restore at a
specific time. A restore point contains information such as registry settings that Windows uses. Restoring to
a previous restore point allows you to reverse changes that have been made to the system since the restore
point was created.

Restoring to an earlier system restore point does not affect data files saved or emails created since the last
restore point, but it does affect software you may have installed.

For example, if you download a photo from a digital camera and then restore the computer to the state it was
on the previous day, the photo remains on the computer.

However, if you install photo viewing software and then restore your computer to the state it was on the
previous day, the software will be uninstalled, and you won't be able to use it.

What you need to know

● If you restore to a restore point and then change your mind, you can undo the restoration.

● You should create system restore points:

◦ Before you add or change software or hardware

◦ Periodically, whenever the computer is running normally

● System Restore also saves shadow copies of files that have been changed since the last restore point
was created. For more information about using shadow copies to restore, see Help and Support.

Creating a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click Create, and follow the on-screen instructions.

To restore, see Restoring to a previous system restore point on page 120.

Backing up system and personal information

Your computer stores information that is important to you, such as files, emails, and photos, and you will
want to keep that information even if you download a virus or the system stops working properly. How
completely you are able to recover your files depends on how recent your backup is. As you add new
software and data files, you should create backups on a regular basis.
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Tips for a successful backup

● Number backup discs before inserting them into the optical drive.

● Store personal files in the Documents, Music, Pictures, and Videos libraries, and back up these folders
periodically.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press prt sc.

3. Open a word-processing document or graphics editing program, and then select Edit > Paste. The
screen image is added to the document.

4. Save and print the document.

What you need to know

● You can back up your information to an optional external hard drive, a flash drive, a network drive, or
discs.

● Connect the computer to AC power during backups.

● Allow enough time for the backup. Depending on files sizes, it may take more than an hour.

● Verify the amount of free space on your backup storage device before you back up.

● You should back up:

◦ Before adding or changing software or hardware.

◦ Before the computer is repaired or restored.

◦ On a regular schedule to be sure you have recent copies of personal information.

◦ After you add many files—for example, if you saved videos from a birthday party.

◦ Before using antivirus software to remove a malicious program.

◦ After adding information that is hard to replace, such as pictures, videos, music, project files, or
data records.

Creating a backup using Windows Backup and Restore

Windows allows you to back up files using Windows Backup and Restore. You can select the level you want to
back up, from individual folders to drives. The backups are compressed to save space. To back up:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. See Help and Support for more information.

To restore, see Restoring specific files using Windows Backup and Restore on page 120.
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Restore and recovery

Restoring to a previous system restore point

Sometimes installing a software program causes your computer or Windows to behave unpredictably.
Usually uninstalling the software fixes the problems. If uninstalling does not fix the problems, you can
restore the computer to a previous system restore point (created at an earlier date and time).

To restore to a previous system restore point, when the computer was running correctly:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore, and follow the on-screen instructions.

Restoring specific files

If files are accidentally deleted from the hard disk and they can no longer be restored from the Recycle Bin, or
if files become corrupt, restoring specific files is useful. Restoring specific files is also useful if you ever
choose to recover the original system using HP Recovery Manager. You can only restore specific files that you
have backed up before.

Restoring specific files using Windows Backup and Restore

Windows allows you to restore files that were backed up using Windows Backup and Restore:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to restore your backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. See Help and Support for more information.

Recovering the original system using HP Recovery Manager

HP Recovery Manager software allows you to repair or recover the computer to its original factory state. 

What you need to know

● HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's website
or reinstall the software from the disc provided by the manufacturer.

● A system recovery should be used as a final attempt to correct computer issues. If you have not already
tried restore points (see Restoring to a previous system restore point on page 120) and partial restores
(see Restoring specific files on page 120), try them before using HP Recovery Manager to recover your
system.

● A system recovery must be performed if the computer hard drive fails or if all attempts to correct any
functional computer issues fail.
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● If the recovery media do not work, you can obtain recovery discs for your system from the HP website.

● The Minimized Image Recovery option is recommended for advanced users only. All hardware-related
drivers and software are re-installed, but other software applications are not. Do not interrupt the
process until it is complete, otherwise the recovery will fail.

Recovering using HP Recovery partition (select models only)

The HP Recovery partition (select models only), allows you to restore your system without the need for
recovery discs or a recovery flash drive. This type of recovery can only be used if the hard drive is still
working.

To check for the presence of a recovery partition, select Start, right-click Computer then select Manage >
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

NOTE: Recovery discs have been included if your computer did not ship with a recovery partition.

1. Access HP Recovery Manager in either of the following ways:

● Select Start  and type recovery in the search field. Select Recovery Manager from the list.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then press f11 while the “F11 (System
Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.

Recovering using the recovery media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical
drive, and then restart the computer.

– or –

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 121.

3. Press f9 at system bootup.

4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for a recovery flash drive:
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1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.

4. Select the flash drive from the boot options window.
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11 Backup and Recovery in SUSE Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up your
system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home
directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save the
backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. Select the Optical Disk option.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the latest
version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD±RW optical drive. You can also restore the
computer to its factory condition from the HP dedicated recovery partition on the hard drive.
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CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The recovery tool
reinstalls the original operating system and HP programs and drivers that were installed at the factory.
Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be
restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery disc. To
create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot menu, and
then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.

NOTE: You can also restore the computer from the partition by restarting the computer, and then pressing
the f11 key.

If you are unable to boot (start up) your computer from the hard drive partition with the primary operating
system or from the recovery partition, and you did not create a system recovery disc, you must purchase a
SUSE Linux Enterprise Desktop Operating System DVD to reinstall the operating system. For additional
information, see the Worldwide Telephone Numbers booklet.
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12 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring
nonvolatile memory that can contain personal data after the system has been powered off and the hard drive
has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally
shipped from HP assuming that no subsequent modifications have been made to the system and assuming
that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed
in the Maintenance & Service Guides available for HP PC products available on the product support pages at
www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the
bottom of the display, or press the ESC key to display the start up menu, then press F10 . If the
system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the
tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this
procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if
more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning
message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor,
one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor;
press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VProTM,
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System
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Configuration, then AMT Options. Then select Unconfigure AMT on next boot. Select Save then
Yes. Select the File menu, and then select Save Changes and Exit. Reboot the system and confirm
that you want to unconfigure AMT.

j. If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate
it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated
on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that,
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when
prompted near the bottom of the display, or press ESC to display the start up menu, then press
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and
select the desired drive. For a higher level of protection, select Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard drive
capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by
powering on the system and pressing F10 when prompted near the bottom of the display. Select
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the
desired hard drive.
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Non-volatile memory usage

Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power is
removed?

What is the
purpose of
this memory?

How is data input into
this memory?

How is this memory
write protected?

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory (CMOS)

256 Bytes No Yes Stores system
date and time
and limited
keyboard
controller
data.

Using the F10 Setup utility
or changing the
Microsoft® Windows®
date & time.

This memory is not
write-protected. HP
recommends
password protecting
the F10 Setup utility.

Controller (NIC)
EEPROM

64 Kbytes
(not
customer
accessible)

No Yes Store NIC
configuration
and NIC
firmware.

Using a utility from the
NIC vendor that can be run
from DOS.

A utility is required to
write data to this
memory and is
available from NIC
vendor. Writing data
to this ROM in an
inappropriate manner
will render the NIC
nonfunctional.

Keyboard ROM 64 Kbytes
(not
customer
accessible)

No Yes Stores
firmware code
(keyboard,
mouse, &
battery
management).

Programmed at the
factory. Code is updated
when the system BIOS is
updated.

A utility is required for
writing data to this
memory and is
available on the HP
website. Writing data
to this ROM in an
inappropriate manner
can render the PC
nonfunctional.

DIMM Serial
Presence
Detect (SPD)
configuration
data

256 Bytes
per memory
module,
128 Bytes
programma
bl e (not
customer
accessible)

No Yes Stores
memory
module
information.

Programmed by the
memory vendor.

Data cannot be written
to this memory when
the module is installed
in a PC. The specific
write protection
method varies by
memory vendor.

System BIOS 4 to 5
MBytes

Yes Yes Store system
BIOS code and
PC
configuration
data.

System BIOS code is
programmed at the
factory. Code is updated
when the system BIOS is
updated. Configuration
data and settings are
input using the F10 setup
utility or a custom utility.

A utility is required for
writing data to this
memory and is
available on the HP
website. Writing data
to this ROM in an
inappropriate manner
can render the PC
nonfunctional.

Intel
Management
Engine
Firmware
(present only in
models ending
in a ‘p’ or ‘w’ or
with Intel
Centrino Pro
technology)

1.5 or
5MByte

Yes Yes Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party
data store.

Management Engine Code
is programmed at the
factory. Code is updated
via Intel secure firmware
update utility. Unique
Provisioning Data can be
entered at the factory or
by an administrator using
the Management Engine
(MEBx) setup utility. The

The Intel chipset is
configured to enforce
HW protection to block
all direct read/write
access to this area. An
Intel utility is required
for updating the
firmware. Only
firmware updates
digitally signed by
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third party data store
contents can populated
by a remote management
console or local
applications registered by
an administrator to have
access to the space.

Intel can be applied
using this utility.

Bluetooth flash 2Mbit No Yes Stores
Bluetooth
configuration
and firmware.

Programmed at the
factory. Tools for writing
data to this memory are
not publicly available but
can be obtained from the
silicon vendor.

A utility is required for
writing data to this
memory and is made
available through
newer versions of the
driver if the flash
requires an upgrade.

802.11 WLAN
EEPROM

4kb to 8kb No Yes Stores
configuration
and calibration
data.

Programmed at the
factory. Tools for writing
data to this memory are
not made public.

A utility is required for
writing data to this
memory and is
typically not made
available to the public
unless a firmware
upgrade is necessary
to address a unique
issue.

Web camera 64K bit No Yes Store Web Cam
configuration
and firmware.

Using a utility from the
device manufacturer that
can be run from Windows.

A utility is required for
writing data to this
memory and is
typically not made
available to the public
unless a firmware
upgrade is necessary
to address a unique
issue.

Fingerprint
reader

512kByte
Flash

Yes Yes Stores
fingerprint
templates.

By enrolling in HP
ProtectTools Security
Manager.

Only a digitally signed
application can make
the call to write to the
flash.
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Questions and answers
1. How can the BIOS settings be restored (returned to factory settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number,
data width, speed/timing, voltage and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is
not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the
write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. Does resetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their factory settings. To return these
system data and configuration defaults to factory settings, refer to question and answer 1 and follow
the instructions for returning the BIOS settings to factory defaults.
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13 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in
the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125
or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet
C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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Country/region Accredited agency Applicable note number

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be
on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm2 or 1.25mm2 conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75mm2 conductor size. KTL logo and individual approval number must be on each
element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mm2 conductor size. Power cord set fittings (appliance coupler, cable, and wall
plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL and CSA or C-
UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3X0.75/1.00mm2 conductor size, with plug BS 1363/A with BSI
or ASTA marks.
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14 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/
recycle.
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